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Kapitel: Anderungsindex Hinweise zur Dokumentation

0 Anderungsindex

Version Anderungen

0.1 erste Vorabversion
0.2 BIOS-Einstellungen aktualisiert
0.3 BIOS-Einstellungen aktualisiert
0.4 Kapitel 3.12 Steckerbeschreibung korrigiert
0.5 LAN Pinbelegung korrigiert
0.6 FAN Pinbelegung korrigiert

L HinweErs

Alle in diesem Handbuch erwéhnten Firmennamen und Produktbezeichnungen sind als eingetragene oder
nicht eingetragene Marken Eigentum ihrer jeweiligen Inhaber und als solche national und international
markenrechtlich geschitzt.
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Hinweise zur Dokumentation Kapitel: Einleitende Hinweise

1 Einleitende Hinweise

1.1 Hinweise zur Dokumentation

Diese Beschreibung wendet sich ausschlie3lich an ausgebildetes Fachpersonal der Steuerungs- und
Automatisierungstechnik, das mit den geltenden nationalen Normen vertraut ist. Zur Installation und
Inbetriebnahme der Komponenten ist die Beachtung der nachfolgenden Hinweise und Erklarungen
unbedingt notwendig.

1.1.1 Haftungsbedingungen

Das Fachpersonal hat sicherzustellen, dass die Anwendung bzw. der Einsatz der beschriebenen Produkte
alle Sicherheitsanforderungen, einschlie3lich sdmtlicher anwendbarer Gesetze, Vorschriften,
Bestimmungen und Normen erfiillt.

Die Dokumentation wurde sorgfaltig erstellt. Die beschriebenen Produkte werden jedoch standig
weiterentwickelt. Deshalb ist die Dokumentation nicht in jedem Fall vollstandig auf die Ubereinstimmung mit
den beschriebenen Leistungsdaten, Normen oder sonstigen Merkmalen geprtift. Keine der in diesem
Handbuch enthaltenen Erklarungen stellt eine Garantie im Sinne von § 443 BGB oder eine Angabe Uber die
nach dem Vertrag vorausgesetzte Verwendung im Sinne von § 434 Abs. 1 Satz 1 Nr. 1 BGB dar. Falls sie
technische Fehler oder Schreibfehler enthélt, behalten wir uns das Recht vor, Anderungen jederzeit und
ohne Anklindigung durchzufiihren. Aus den Angaben, Abbildungen und Beschreibungen in dieser
Dokumentation kénnen keine Anspriiche auf Anderung bereits gelieferter Produkte gemacht werden.

1.1.2 Copyright

© Diese Dokumentation ist urheberrechtlich geschitzt. Jede Wiedergabe oder Drittverwendung dieser
Publikation, ganz oder auszugsweise, ist ohne schriftliche Erlaubnis der Beckhoff Automation GmbH
verboten.

Beckhoff New Automation Technology CB3055 Seite 7



Kapitel: Einleitende Hinweise Sicherheitshinweise

1.2 Sicherheitshinweise

Beachten Sie bitte die folgenden Sicherheitshinweise und Erklarungen! Produktspezifische
Sicherheitshinweise finden Sie auf den folgenden Seiten oder in den Bereichen Montage, Verdrahtung,
Inbetriebnahme usw.

1.2.1 Auslieferungszustand

Die gesamten Komponenten werden je nach Anwendungsbestimmungen in bestimmten Hard- und
Software-Konfigurationen ausgeliefert. Anderungen der Hard- oder Software-Konfiguration, die tiber die
dokumentierten Méglichkeiten hinausgehen, sind unzuléssig und bewirken den Haftungsausschluss der
Beckhoff Automation GmbH.

1.2.2 Erklarung der Sicherheitssymbole

In der vorliegenden Dokumentation werden die folgenden Sicherheitssymbole verwendet. Diese Symbole
sollen den Leser vor allem auf den Text des darunter stehenden Sicherheitshinweises aufmerksam
machen Dieser Sicherheitshinweis ist aufmerksam zu lesen und unbedingt zu befolgen.

A AKUTE VERLETZUNGSGEFAHR!

Wenn der Sicherheitshinweis unter diesem Symbol nicht beachtet wird, besteht unmittelbare Gefahr fur
Leben und Gesundheit von Personen.

A VORSICHT, VERLETZUNGSGEFAHR!

Wenn der Sicherheitshinweis unter diesem Symbol nicht beachtet wird, besteht Gefahr fir Leben und
Gesundheit von Personen.

A GEFAHR FUR PERSONEN, UMWELT, GERATE ODER DATEN!

Wenn der Sicherheitshinweis unter diesem Symbol nicht beachtet wird, kdnnen Personen, Umwelt oder
Gerate geschadigt oder Daten geléscht werden.

l HINWEIS, TIPP ODER FINGERZEIG

Dieses Symbol kennzeichnet Informationen, die zum besseren Verstandnis beitragen.

Seite 8 Beckhoff New Automation Technology CB3055



Grundlegende SicherheitsmalRhahmen Kapitel: Einleitende Hinweise

1.3 Grundlegende Sicherheitsmal3ihahmen

1.3.1 Sorgfaltspflicht des Betreibers
Der Betreiber muss sicherstellen, dass

o das Produkt nur bestimmungsgemalf verwendet wird.

o das Produkt nur in einwandfreiem, funktionstiichtigem Zustand betrieben wird.

o die Betriebsanleitung stets in einem leserlichen Zustand und vollstdndig am Einsatzort des Produkts
zur Verfligung steht.

o nur ausreichend qualifiziertes und autorisiertes Personal das Produkt bedient.

o dieses Personal regelmaRig in allen zutreffenden Fragen von Arbeitssicherheit und Umweltschutz
unterwiesen wird, sowie die Betriebsanleitung und insbesondere die darin enthaltenen
Sicherheitshinweise kennt.

1.3.2 Nationale Vorschriften je nach Maschinentyp

Je nach Maschinen- und Anlagentyp, in dem das Produkt zum Einsatz kommt, bestehen nationale
Vorschriften fir Steuerungen solcher Maschinen und Anlagen, die der Betreiber einhalten muss. Diese
Vorschriften regeln unter anderem, in welchen Zeitabstanden die Steuerung Uberprift werden muss. Der
Betreiber muss diese Uberpriifung rechtzeitig veranlassen.

1.3.3 Anforderungen an das Bedienungspersonal

o Betriebsanleitung lesen: Jeder Benutzer des Produkts muss die Betriebsanleitung fir die Anlage, an
der er eingesetzt wird, gelesen haben.
o Systemkenntnisse: Jeder Benutzer muss alle fir ihn erreichbaren Funktionen des Produkts kennen.

Beckhoff New Automation Technology CB3055 Seite 9



Kapitel: Einleitende Hinweise Funktionsumfang

1.4 Funktionsumfang

L HinwEIS

Die in der vorliegenden Dokumentation enthaltenen Beschreibungen stellen eine umfassende
Produktbeschreibung dar. Soweit das beschriebene Motherboard als Bestandteil eines Industrie-PC der
Beckhoff Automation GmbH erworben worden ist, findet die hierin enthaltene Produktbeschreibung nur in
eingeschranktem Umfang Anwendung. Maf3geblich sind die vereinbarten Spezifikationen des
entsprechenden Industrie-PC der Beckhoff Automation GmbH. Durch verschiedene Bauformen der
Industrie-PC kann es zu Abweichungen in der Bauteilbestiickung des Motherboards kommen. Support-
und Serviceleistungen der Beckhoff Automation GmbH fiir das eingebaute Motherboard erstrecken sich
ausschlieB3lich auf die Produktbeschreibung einschlie3lich Betriebssystem des jeweiligen Industrie-PC.

Seite 10 Beckhoff New Automation Technology CB3055



Eigenschaften Kapitel: Ubersicht

2 Ubersicht
2.1 Eigenschaften

Das CB3055 ist ein hochkomplexes 3,5-Zoll-Board mit der Funktionalitat eines Motherboards. Es basiert
auf Intel®-CPUs der Core™- und Celeron®-Familien (2. Generation, BGA, embedded) in Verbindung mit
dem QM67-PCH-Chip. Modernste DDR3-Technologie ermdglicht einen Speicherausbau von bis zu 8
GByte (DDR3-1066/1333/1600) Giber SO-DIMM204. Neben einem PCI-Express-Bus (ein 4x oder bis zu vier
1x) steht auch zusatzliche Peripherie zur Verfiigung wie eine serielle Schnittstelle, drei
Gigabit-LAN-Anschlusse, Ton-Ein- und -Ausgang, neun USB-Schnittstellen, CRT- und
DVI/HDMI/DisplayPort-Anschliisse und vier SATA-Ports, davon zwei mit bis zu 6Gb/s Ubertragungsrate.
Eingangsspannung ist 24V, die galvanisch von den auf dem Board erzeugten Spannungen getrennt sind.

24v —|
Power DC/DC 1x SO-DIMM204
(VCCCore; VTT; Intel® Celeron® ! DDR3-
Battery ——| DDRVTT, GFXVCC 827E ———)/ 1066/1333/1600
1,05V; 1,5V; 1,8V;
3,3V)
BIOS sl gl |3 NXP®
- *‘ SMBuUS PCA9535 [T 8x GPIO
SMBus
USB1-9 USB 2.0
—— SPDIFi
O Pete x4 < PCle (x1) pi e QM67 Fein HDA Link REEIED :: EIPNDE"I:NO
1x PCle x4 —/ ALC8S9 | | | \\EouT
—r— MIC
s ®245) ——| ggeral | — ﬁ Li’:ﬁiff’s A
Intel® | N Intel® f
LAN2 (RJ45
( ) 82574t N “/ 82574l PWRCTRL3 [I—— SMSC® —r— KB
uc " | SCH3114 |—— MS
~
- =
2 5T 5% o o~
s 82 ¢
s 2T go=
E 3
o Prozessor Intel® Celeron® 827E
o Chipsatz Intel® QM67 PCH
o SO-DIMM204-Steckplatz fiir bis zu 8 GByte DDR3-1066/1333/1600
o PCI-Express Uber 2x40poligen Custom-Stecker (bis zu vier x1 oder ein x4)
o Serielle Schnittstelle COM1
o Drei LAN-Anschliisse Ethernet 10/100/1000 (Base-T)
o Vier SATA-Anschlisse (2x 1,5/3 Gb/s, 2x 1,5/3/6 Gh/s)
o PS2-Keyboard- und -Maus-Schnittstelle
o Neun USB-2.0-Schnittstellen (4x extern, 4x intern, 1x auf I-PEX-Stecker)
o BIOS AMI® Aptio
o CRT-Anschluss
o Zwei DVI/HDMI-Anschlisse (1x DVI-1, 1x I-PEX inkl. DisplayPort)
o HDA-kompatible Soundausgabe mit SPDIF-Ein- und -Ausgang
Beckhoff New Automation Technology CB3055 Seite 11



Kapitel: Ubersicht

Eigenschaften

o 8xGPIO

o RTC mit externer CMOS-Batterie

o 24V-Versorgungsspannung, galvanisch getrennt
o Format: 102 mm x 147 mm

Seite 12
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Spezifikationen und Dokumente Kapitel: Ubersicht

2.2 Spezifikationen und Dokumente

Fur die Erstellung dieses Handbuchs bzw. als weiterfiihrende technische Dokumentation wurden die
folgenden Dokumente, Spezifikationen oder Internetseiten verwendet.

= PCI-Spezifikation
Version 2.3 bzw. 3.0
WWW.pCisig.com

= PCI Express® Base Specification
Version 2.0
WWW.pcisig.com

= ACPI-Spezifikation
Version 3.0
www.acpi.info

= USB-Spezifikationen
www.usb.org

= SM-Bus-Spezifikation
Version 2.0
www.smbus.org

= Intel®-Chipsatzbeschreibung
Intel® 6 Series Chipset datasheet
www.intel.com

= Intel®-Chipbeschreibungen
Intel® Atom™ Processor Family Mobile datasheet
www.intel.com

= Intel®-Chipbeschreibung
82579L Datasheet
www.intel.com

= Intel®-Chipbeschreibung
82574L Datasheet
www.intel.com

=  SMSC®-Chipbeschreibung
SCH3114 Datasheet
WWW.SmMSC.com
(NDA erforderlich)

= Realtek®-Chipbeschreibung
ALC885/889 Datasheet
www.realtek.com.tw

= American Megatrends®
Aptio™ Text Setup Environment (TSE) User Manual
Www.ami.com

= American Megatrends®
Aptio™ 4 .x Status Codes
www.ami.com

Beckhoff New Automation Technology CB3055 Seite 13



Kapitel: Anschliisse Spezifikationen und Dokumente

3 Anschlusse

Auf den folgenden Seiten werden samtliche Steckverbinder auf dem CB3055 beschrieben.

A ACHTUNG

Die verwendeten Kabel missen fir die meisten Schnittstellen bestimmten Anforderungen gentigen. Fur
eine zuverlassige USB-2.0-Verbindung sind beispielsweise verdrillte und geschirmte Kabel notwendig.
Einschrankungen bei der maximalen Kabellange sind auch nicht selten. Samtliche dieser
schnittstellenspezifischen Erfordernisse sind den jeweiligen Spezifikationen zu entnehmen und
entsprechend zu beachten.

Seite 14 Beckhoff New Automation Technology CB3055



Steckeriibersicht

Kapitel: Anschlisse

3.1 Steckerubersicht

In der folgenden Abbildung sind die Steckeranschliisse auf der Bestiickungsseite des CB3055-Boards
zusammengefasst. Aus der Tabelle darunter kann die Funktion des jeweiligen Steckers entnommen
werden, ebenso wie die Handbuchseite, auf der weitergehende Informationen zu diesem Anschluss

nachgelesen werden kénnen.

7  po 12 9 pias 16 13 P1302 24 79 P500 1 7 e 12 1 3
sl RIS oY | | iiiin R
1 6 1 8 1 12 80 2 1 6 476
6 10
Pooo 33008
1— d5 AR Ak ol (AL LG
6 10 [ feso:
1 5 o = ‘ m P503
6 10 | X - -
v SRR ! ' \ S
- = : : [,
135#7 3l
M P501
p12012(30 : ' o LA =
us00 SO-DIMM204 L — %
-I - | . P1401 P1402 x '
1 8 C1C2 1234 1234 = EH00 fia)
SEEEEEEE . P1700
9::::::::*05 g = &1ﬂﬂnﬂn’ln€“
- : 8 1 1 8
P501/2/3/4 "SATA-Schnittstellen” Seite 30
U600/1 "Speicher" Seite 19
P700 "GPIO" Seite 34
P800/900/1000 "LAN" Seite 28
P1200 "VGA/DVI" Seite 22
P1201 "DVI/HDMI/DisplayPort" Seite 24
P1300 "Ton" Seite 29
P1301 "Lifteranschliisse" Seite 35
P1302 "System" Seite 18
P1401/2 "USB 1-4" Seite 26
P1403 "USB 5-8" Seite 27
P1404 "Serielle Schnittstelle COM1" Seite 31
P1700 "Stromversorgung" Seite 16
P1900 "Stromausgang" Seite 17
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Kapitel: Anschliisse Stromversorgung

3.2 Stromversorgung

Der Anschluss fur die Stromversorgung ist als 8-poliger Gehausestecker (Weidmdller 180537-0000)
realisiert. An den Pins 5 und 6 liegt die Hauptspannungsversorgung (24V) der Baugruppe an. Ein externer
Bleiakku kann als USV an den Pins 1 und 2 angeschlossen werden. lhr Distributor informiert Sie gerne tber
die in Frage kommenden Akkus.

Pin 3 (UPS_OUT) ist ein 24V-Output (max. 2A), der auch nach Aktivierung der USV (Bleiakku oder
kapazitiv) weiterversorgt wird (z.B. fiir ein Display, auf dem der Stromausfall angezeigt werden kann).
Wenn man das Board abschalten méchte, ohne die USV zu aktivieren, dann kann hierzu Pin 7 (PC_ON)
genutzt werden. Legt man dort 24V an, dann féahrt die Baugruppe ordnungsgeman herunter, ohne die
Akkus der USV zu belasten. Pin 8 (Power Status) wird nach Abschluss dieses Vorgangs von 24V auf OV
gelegt. Das Gleiche gilt fur UPS_OUT, sodass Gerate, die dort angeschlossen sind, ebenfalls abgeschaltet
werden und die Akkus nicht belasten.

P1700

¢ o o p o oo o o @

1 8

Pinbelegung Stromstecker:

Pin Name Beschreibung
1 BATT24V# Bleiakku 24V -
2 BATT24V Bleiakku 24V +
3 UPS OUT USV Ausgangsspannung 24V
4 GND Masse
5 24V# Versorgungsspannung 24V -
6 24V Versorgungsspannung 24V +
7 PC ON# Power On
8 PWRSTAT Power Status

Seite 16 Beckhoff New Automation Technology CB3055



Stromausgang

Kapitel: Anschlisse

3.3 Stromausgang

Zur Stromversorgung externer Gerate dient ein 2x3poliger Molex-Stecker. Der tiber VCC/SVCC
entnommene Strom darf in der Summe 2A nicht Ubersteigen, fur 12V ist der maximale Strom ebenfalls 2A.
Im Falle eines Stromausfalls werden die hier zur Verfigung gestellten Spannungen nur dann aufrecht
erhalten, wenn eine Bleiakku-USV oder eine SUSV angeschlossen ist.

nnnnnn

1RARHA

Pinbelegung Stromstecker Molex 2x3:

Beschreibung Name Pin Name Beschreibung
Masse GND 1 4 VCC Versorgungsspannung 5V
Reserviert RES 2 5 SVCC Standby-Versorgung 5V
Reserviert RES 3 6 12v Versorgungsspannung 12V

Beckhoff New Automation Technology CB3055
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Kapitel: Anschlisse

System

3.4 System

Verschiedene Systemsignale sowie ein SMBus-Interface werden uber einen 2x12poligen Wannenstecker
herausgefuhrt (FCI 98424-G52-24LF, passender Gegenstecker FCI 90311-024LF). Hier werden
Powerbutton, Reset, Tastatur, Lautsprecher, LEDs fiir Harddisk und fiir Suspend-Modus angeschlossen
sowie drei weitere Status-LEDs, die Uber GPIOs angesteuert werden. Von diesen drei LEDs sind LED1 und
LED?2 bereits mit Vorwiderstanden ausgestattet. SMBus-fahige Geréate kdnnen ebenfalls angeschlossen

werden.

1 3 P1302

24

1 12

...........

nonnn n-li =

L. 3

(I |

Pinbelegung 2x12-Wannenstecker:

Beschreibung Name Pin Name Beschreibung
Masse GND 1 13 3,3V Versorgungsspannung 3,3V
Reset nach Masse RSTBTN# |2 14 PWRBTN# On/Suspend-Taste
LED Suspend / ACPI S-LED 3 15 S3,3V Standby-Versorgung 3,3V
LED Harddisk SATALED |4 16 GPIOLED3 |LED GPIO-Gerét 3
LED GPIO-Gerét 1 GPIOLED1 |5 17 BATT RTC-Batterie
LED GPIO-Gerét 2 GPIOLED2 |6 18 SMBALERT# |SMB Alert
SMB Clock SMBCLKEX |7 19 SMBDATEX [SMB Data
Lautsprecher SPEAKER |8 20 SVCC Standby-Versorgung 5V
Tastatur Clock KCLK 9 21 KDAT Tastatur Data
Masse GND 10 22 VCC Versorgungsspannung 5V
Masse GND 11 23 VCC Versorgungsspannung 5V
Masse GND 12 24 VCC Versorgungsspannung 5V
Seite 18 Beckhoff New Automation Technology CB3055
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Kapitel: Anschlisse

3.5 Speicher

Auf dem CB3055-Board kommen SO-DIMM204-Speichermodule (DDR3-1066/1333/1600), wie sie in
Notebooks ublich sind, zum Einsatz. Aus technischen und mechanischen Griinden ist es méglich, dass
bestimmte Speichermodule nicht eingesetzt werden kdnnen. Informieren Sie sich bei lhrem Distributor tiber
die empfohlenen Speichermodule.
Mit derzeit erhaltlichen SO-DIMM204-Modulen ist ein Speicherausbau bis 8 GByte mdglich.
Alle Timingparameter fiir die unterschiedlichen Fabrikate und Ausbaustufen werden durch das BIOS
automatisch eingestellt.

.......

PN

nnnnn

2 72 74 U800 204 3
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my g ey Fag | R
1 71 73 203 1 | |
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Beschreibung Name Pin Name Beschreibung

Referenzspannung Memory |REF-DQ 1 2 GND Masse
Masse GND 3 4 DQ4 Datenleitung 4
Datenleitung 0 DQO 5 6 DQ5 Datenleitung 5
Datenleitung 1 DQ1 7 8 GND Masse
Masse GND 9 10 DQSO0# Data Strobe 0 -
Data Mask 0 DMO 11 12 DQSO0 Data Strobe 0 +
Masse GND 13 14 GND Masse
Datenleitung 2 DQ2 15 16 DQ6 Datenleitung 6
Datenleitung 3 DQ3 17 18 DQ7 Datenleitung 7
Masse GND 19 20 GND Masse
Datenleitung 8 DQ8 21 22 DQ12 Datenleitung 12
Datenleitung 9 DQ9 23 24 DQ13 Datenleitung 13
Masse GND 25 26 GND Masse
Data Strobe 1 - DQS1# 27 28 DM1 Data Mask 1
Data Strobe 1 + DQS1 29 30 RESET# Reset
Masse GND 31 32 GND Masse
Datenleitung 10 DQ10 33 34 DQ14 Datenleitung 14
Datenleitung 11 DQ11 35 36 DQ15 Datenleitung 15
Masse GND 37 38 GND Masse
Datenleitung 16 DQ16 39 40 DQ20 Datenleitung 20
Datenleitung 17 DQ17 41 42 DQ21 Datenleitung 21
Masse GND 43 44 GND Masse
Data Strobe 2 - DQS2# 45 46 DM2 Data Mask 2
Data Strobe 2 + DQS2 47 48 GND Masse
Beckhoff New Automation Technology CB3055 Seite 19
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Speicher

Beschreibung Name Pin Name Beschreibung
Masse GND 49 50 DQ22 Datenleitung 22
Datenleitung 18 DQ18 51 52 DQ23 Datenleitung 23
Datenleitung 19 DQ19 53 54 GND Masse
Masse GND 55 56 DQ28 Datenleitung 28
Datenleitung 24 DQ24 57 58 DQ29 Datenleitung 29
Datenleitung 25 DQ25 59 60 GND Masse
Masse GND 61 62 DQS3# Data Strobe 3 -
Data Mask 3 DQM3 63 64 DQS3 Data Strobe 3 +
Masse GND 65 66 GND Masse
Datenleitung 26 DQ26 67 68 DQ30 Datenleitung 30
Datenleitung 27 DQ27 69 70 DQ31 Datenleitung 31
Masse GND 71 72 GND Masse
Clock Enables 0 CKEO 73 74 CKE1 Clock Enables 1
Versorgungsspannung 1,5V 1,5V 75 76 1,5V Versorgungsspannung 1,5V
Reserviert N/C 77 78 (A15) Reserviert
SDRAM Bank 2 BA2 79 80 Al4 Adressleitung 14
Versorgungsspannung 1,5V 1,5V 81 82 1,5V Versorgungsspannung 1,5V
Adressleitung 12 (Burst Al12/BC# 83 84 All Adressleitung 11
Chop)
Adressleitung 9 A9 85 86 A7 Adressleitung 7
Versorgungsspannung 1,5V 1,5V 87 88 1,5V Versorgungsspannung 1,5V
Adressleitung 8 A8 89 90 A6 Adressleitung 6
Adressleitung 5 A5 91 92 A4 Adressleitung 4
Versorgungsspannung 1,5V [1,5V 93 94 1,5V Versorgungsspannung 1,5V
Adressleitung 3 A3 95 96 A2 Adressleitung 2
Adressleitung 1 Al 97 98 A0 Adressleitung 0
Versorgungsspannung 1,5V [1,5V 99 100 1,5V Versorgungsspannung 1,5V
Clock 0 + CKO 101 102 CK1 Clock 1 +
Clock 0 - CKO# 103 104 CK1# Clock 1 -
Versorgungsspannung 1,5V [1,5V 105 106 1,5V Versorgungsspannung 1,5V
Adressleitung 10 A10/AP 107 108 BAl SDRAM Bank 1
(Autoprecharge)
SDRAM Bank 0 BAO 109 110 RAS# Row Address Strobe
Versorgungsspannung 1,5V |[1,5V 111 112 1,5V Versorgungsspannung 1,5V
Write Enable WE# 113 114 SO# Chip Select 0
Column Address Strobe CAS# 115 116 ODTO On Die Termination 0
Versorgungsspannung 1,5V [1,5V 117 118 1,5V Versorgungsspannung 1,5V
Adressleitung 13 Al3 119 120 ODT1 On Die Termination 1
Chip Select 1 S1# 121 122 N/C Reserviert
Versorgungsspannung 1,5V 1,5V 123 124 1,5V Versorgungsspannung 1,5V
Reserviert (TEST) 125 126 REF-CA Referenzspannung
Masse GND 127 128 GND Masse
Datenleitung 32 DQ32 129 130 DQ36 Datenleitung 36
Datenleitung 33 DQ33 131 132 DQ37 Datenleitung 37
Masse GND 133 134 GND Masse
Data Strobe 4 - DQS4# 135 136 DQM4 Data Mask 4
Data Strobe 4 + DQS4 137 138 GND Masse
Masse GND 139 140 DQ38 Datenleitung 38
Datenleitung 34 DQ34 141 142 DQ39 Datenleitung 39
Datenleitung 35 DQ35 143 144 GND Masse
Masse GND 145 146 DQ44 Datenleitung 44
Datenleitung 40 DQ40 147 148 DQ45 Datenleitung 45
Datenleitung 41 DQ41 149 150 GND Masse
Masse GND 151 152 DQS5# Data Strobe 5 -
Data Mask 5 DQM5 153 154 DQS5 Data Strobe 5 +
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Beschreibung Name Pin Name Beschreibung

Masse GND 155 156 GND Masse

Datenleitung 42 DQ42 157 158 DQ46 Datenleitung 46

Datenleitung 43 DQ43 159 160 DQA47 Datenleitung 47

Masse GND 161 162 GND Masse

Datenleitung 48 DQ48 163 164 DQ52 Datenleitung 52

Datenleitung 49 DQ49 165 166 DQ53 Datenleitung 53

Masse GND 167 168 GND Masse

Data Strobe 6 - DQS6# 169 170 DQM6 Data Mask 6

Data Strobe 6 DQS6 171 172 GND Masse

Masse GND 173 174 DQ54 Datenleitung 54

Datenleitung 50 DQ50 175 176 DQ55 Datenleitung 55

Datenleitung 51 DQ51 177 178 GND Masse

Masse GND 179 180 DQ60 Datenleitung 60

Datenleitung 56 DQ56 181 182 DQ61 Datenleitung 61

Datenleitung 57 DQ57 183 184 GND Masse

Masse GND 185 186 DQS7# Data Strobe 7 -

Data Mask 7 DQM7 187 188 DQS7 Data Strobe 7 +

Masse GND 189 190 GND Masse

Datenleitung 58 DQ58 191 192 DQ62 Datenleitung 62

Datenleitung 59 DQ59 193 194 DQ63 Datenleitung 63

Masse GND 195 196 GND Masse

SPD-Adresse 0 SAQ 197 198 EVENT# Event

Versorgungsspannung 3,3V [3,3V 199 200 SDA SMBus Data

SPD-Adresse 1 SAl 201 202 SCL SMBus Clock

Terminierungsspannung VTT 203 204 VTT Terminierungsspannung

Beckhoff New Automation Technology CB3055
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VGA/DVI

3.6

VGA/DVI

Das Board verfiigt tber einen DVI-I-Anschluss, an den ein DVI-fahiger Monitor oder — ggf. mit einem
entsprechenden DVI-DSUB-Adapter — ein Standard-VGA-Monitor angeschlossen werden kann. Es besteht
auBBerdem die Mdéglichkeit, mit Hilfe eines HDMI-Adapters einen HDMI-Bildschirm anzuschlie3en.
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Pinbelegung DVI-I:
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Pin Name Beschreibung
1 TMDSDAT2# |DVI-Daten 2 -
2 TMDSDAT?2 DVI-Daten 2 +
3 GND Masse
4 N/C Reserviert
5 N/C Reserviert
6 DDC CLK DDC Clock (DVI/VGA)
7 DDC DAT DDC Data (DVI/VGA)
8 VSYNC VGA Vertikaler Sync
9 TMDSDAT1# |DVI-Daten 1 -
10 |TMDSDAT1 DVI-Daten 1 +
11 |GND Masse
12 |N/C Reserviert
13 [N/C Reserviert
14  |VCC Versorgungsspannung 5V
15 |GND Masse
16 |HP_DETECT |Hot Plug Detect
17 |TMDSDATO# DVI-Daten O -
18 |TMDSDATO DVI-Daten 0 +
19 |GND Masse
20 |N/C Reserviert
21 |N/C Reserviert
22 |GND Masse
23 |TMDS CLK DVI-Clock
24 |TMDS CLK# DVI-Clock
Cl |RED VGA Rot
C2 |GREEN VGA Grin
C3 |BLUE VGA Blau
C4 |HSYNC VGA Horizontaler Sync
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Pin

Name

Beschreibung

C5

GND

Masse
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3.7 DVI/HDMI/DisplayPort

Das CB3055 verfiigt noch Uber einen weiteren DVI-Anschluss, der als 30poliger Flachkabelstecker
realisiert ist (I-PEX Cabline-VS 20455-030E-12). Analoge VGA-Signale liegen an diesem Anschluss nicht
an, es kann aber ein HDMI- oder DisplayPort-Bildschirm angeschlossen werden. Aul3erdem wird Uber
diesen Stecker ein weiterer USB-Kanal herausgefuhrt. Bitte beachten Sie, dass zur Verwendung dieser
Schnittstelle ein spezielles I-PEX-Kabel benétigt wird.

Pinbelegung 30pol-Flachkabelstecker DVI/HDMI/DisplayPort:

Pin Name Beschreibung
1 TMDSO#/DP2# DVI Data 0 -/DP Lane 2 -
2 TMDSO0/DP2 DVI Data 0 +/DP Lane 2 +
3 TMDSI1#/DP1# DVIDatal-/DP Lane 1 -
4 TMDS1/DP1 DVIDatal+/DPLanel+
5 TMDS2#/DPO# DVI Data 2 - / DP Lane O -
6 TMDS2/DP0 DVIData2 +/DP Lane 0 +
7 TMDSCLK#/DP3# DVI Clock - / DP Lane 3 -

8 TMDSCLK/DP3 DVI Clock + / DP Lane 3 +
9 N/C Reserviert

10 |[SEL_DVI/DP# DVI-DisplayPort Select

11 DDCK/DPAUX EDID Clock / DP Aux +

12 DDDA/DPAUX# EDID Data / DP Aux -

13 |VCC Versorgungsspannung 5V
14 |GND Masse

15 [HPD Hot Plug Detect

16 [USBVCC USB-Versorgung 5V

17 |USBVCC USB-Versorgung 5V

18 [N/C Reserviert

19 [N/C Reserviert

20 |N/C Reserviert

21 |N/C Reserviert

22 |USB# USB -

23 |USB USB +

24 IN/C Reserviert

25 |[N/C Reserviert

26 |[3.3V Versorgungsspannung 3,3V
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Pin Name Beschreibung
27 |3.3V Versorgungsspannung 3,3V
28 |VCC Versorgungsspannung 5V
29 |VCC Versorgungsspannung 5V
30 |VCC Versorgungsspannung 5V

Beckhoff New Automation Technology CB3055
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3.8 USB 14

Die USB-Kanéle 1 bis 4 sind in Form von Standard-USB-Steckern herausgefuhrt.

Die USB-Kanéle unterstiitzen die USB-Spezifikation 2.0. Durch das BIOS kdnnen alle notwendigen
Einstellungen fir USB durchgefihrt werden. Es ist zu beachten, dass die Funktionalitat ,USB-Maus und
Tastatur des BIOS-Setup nur bendtigt wird, wenn das Betriebssystem keine USB-Unterstiitzung bietet.
Fur Einstellungen im Setup und zum Booten von Windows mit einer angeschlossenen USB-Maus und
Tastatur sollte diese Funktion nicht gewahlt werden, weil dies zu erheblichen Leistungseinschrankungen
fuhren wirde.

Die einzelnen USB-Schnittstellen kénnen bis zu 500mA Strom liefern und sind elektronisch abgesichert.
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Pinbelegung USB2.0-Stecker fur Port X:

Pin Name Beschreibung
1 VCC 5V fir USBX
2 USBX# Minus-Datenkanal USBX
3 USBX Plus-Datenkanal USBX
4 GND Masse
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3.9 USB 5-8

Die USB-Kanéle 5 bis 8 werden Uber einen 2x8poligen Wannenstecker zur Verfigung gestellt (FCI
98424-G52-16LF, passender Gegenstecker FCI 90311-016LF).

Die USB-Kanéle unterstiitzen die USB-Spezifikation 2.0. Durch das BIOS kdnnen alle notwendigen
Einstellungen fiir USB durchgefiihrt werden. Es ist zu beachten, dass die Funktionalitat ,USB-Maus und
Tastatur” des BIOS-Setup nur benétigt wird, wenn das Betriebssystem keine USB-Unterstiitzung bietet.
Fur Einstellungen im Setup und zum Booten von Windows mit einer angeschlossenen USB-Maus und
Tastatur sollte diese Funktion nicht gewahlt werden, weil dies zu erheblichen Leistungseinschrankungen
fuhren wirde.

Die einzelnen USB-Schnittstellen kénnen bis zu 500mA Strom liefern und sind elektronisch abgesichert.

A AARADy

Pinbelegung Wannenstecker USB 5-8

Beschreibung Name Pin Name Beschreibung
5V fur USB5 VCC 1 9 VCC 5V fur USB6
Minus-Datenkanal USB5 USB5- 2 10 USB6- Minus-Datenkanal USB6
Plus-Datenkanal USB5 USB5+ 3 11 USB6+ Plus-Datenkanal USB6
Masse GND 4 12 GND Masse
Masse GND 5 13 GND Masse
Plus-Datenkanal USB7 USB7+ 6 14 USB8+ Plus-Datenkanal USB8
Minus-Datenkanal USB7 USB7- 7 15 USB8- Minus-Datenkanal USB8
5V fur USB7 VCC 8 16 VCC 5V fur USB8
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LAN

3.10LAN

Das Board verfuigt uber drei Gigabit-LAN-Anschlisse. An allen kénnen 10BaseT-, 100BaseT- und
1000BaseT-kompatible Netzwerkkomponenten angeschlossen werden. Die erforderliche Geschwindigkeit
wird automatisch gewahlt. Auto-Cross und Auto-Negotiate stehen ebenso zur Verfiigung wie PXE-, RPL-
und WOL-Funktionalitat. Controller sind Intel®'s 82579L (PHY, LAN1) und 82574L (MAC/PHY, LAN2).
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Pinbelegung LAN 10/100/1000:

A ARARAR

Pin Name Beschreibung

1 LAN-0 LAN Leitung O Plus

2 LAN-0# LAN Leitung 0 Minus

3 LAN-1 LAN Leitung 1 Plus

4 LAN-2 LAN Leitung 2 Plus

5 LAN-2# LAN Leitung 2 Minus

6 LAN-1# LAN Leitung 1 Minus

7 LAN-3 LAN Leitung 3 Plus

8 LAN-3# LAN Leitung 3 Minus
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3.11Ton

Die Audio-Funktionen sind tber einen 2x5poligen Wannenstecker erreichbar (FCI 98424-G52-10LF,
passender Gegenstecker FCI 90311-010LF). Die Signale fiir Tonein- und -ausgabe haben dabei eine
Doppelfunktion. Standard ist die bekannte Tonausgabe-, Toneingabe- und Mikrofon-Funktion. Durch die
Treiber fir das jeweilige Betriebssystem kénnen diese Signale auf einen 5.1-Ausgang umgeschaltet
werden. In diesem Modus stehen keine Toneingabemdglichkeiten mehr zur Verfigung. Alle Signale
werden zur Tonausgabe verwendet.

Die Signale ,SPDIFI“ und ,SPDIFO* erméglichen die digitale Ein- und Ausgabe. Die dafir erforderliche
Umsetzung auf Koax bzw. optisch muss extern erfolgen.

Beschreibung Name Pin Name Beschreibung
Digital Ausgang SPDIF SPDIFO 1 6 3,3V Versorgungsspannung 3,3V
Digital Eingang SPDIF SPDIFI 2 7 S_AGND Analog Masse Ton
Ton Ausgang rechts / LOUT_R/ |3 8 LOUT_L/ Ton Ausgang links /
Ausgang vorn rechts FRONT_R FRONT_L [Ausgang vorn links
AUX Eingang rechts / AUXA_R/ |4 9 AUXA_L/ AUX Eingang links /
Ausgang hinten rechts REAR_R REAR_L Ausgang hinten links
Mikrophone 1 Eingang / MIC1/ 5 10 Mic2 / Mikrophone 2 Eingang /
Ausgang Center CENTER LFE Ausgang Subwoofer
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3.12SATA-Schnittstellen

Das CB3055-Board ist mit vier SATA-Schnittstellen ausgestattet, von denen die ersten beiden eine
Ubertragungsrate von bis zu 6Gb/s erlauben. Die anderen beiden erlauben bis zu 3Gb/s. Die Schnittstellen
stehen als 7polige SATA-Stecker zur Verfliigung. Es werden RAID 0/1/5/10 unterstitzt.

Die notwendigen Einstellungen werden Uber das BIOS-Setup vorgenommen.
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Pinbelegung SATA:

Pin Name Beschreibung

1 GND Masse

2 SATATX SATA Senden +

3 SATATX# SATA Senden -

4 GND Masse

5 SATARX# SATA Empfangen -

6 SATARX SATA Empfangen +

7 GND Masse
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3.13Serielle Schnittstelle COM1

Die auf dem Board vorhandene serielle Schnittstelle COM1 wird {iber einen 2x5poligen Wannenstecker
herausgefihrt (FCI 98424-G52-10LF, passender Gegenstecker FCI 90311-010LF). Die Signalpegel
entsprechen RS232.

Die Port-Adresse und der benutzte Interrupt werden mit Hilfe des BIOS-Setups eingestellt.

Beschreibung Name Pin Name Beschreibung
Data Carrier Detect DCD 1 6 DSR Data Set Ready
Receive Data RXD 2 7 RTS Request to Send
Transmit Data TXD 3 8 CTS Clear to Send
Data Terminal Ready DTR 4 9 RI Ring Indicator
Masse GND 5 10 VCC Versorgungsspannung 5V

StandardmaRig werden an dem 2x5poligen Stecker Maus- und Keyboardsignale herausgefuhrt.

Pinout COM-Stecker bei Bestiickungsoption Keyboard/Mouse:

Beschreibung Name Pin Name Beschreibung
Keyboard Clock KCLK 1 6 MCLK Mouse Clock
Keyboard Data KDAT 2 7 MDAT Mouse Data
Reserviert N/C 3 8 N/C Reserviert
Reserviert N/C 4 9 N/C Reserviert
Masse GND 5 10 3,3V Versorgungsspannung 3,3V
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PCI-Express

3.14PCI-Express

Das CB3055 ist mit einem herstellerspezifischen 2x40poligen Stecker ausgestattet, tiber den
PCI-Express-Geréate angeschlossen werden kénnen. Es kdnnen entweder bis zu vier PClelx-Geréate oder
genau ein PCle4x-Gerat angeschlossen werden. Adapterkarten mit Standard-PCle-Sockeln sowie mit
PCle-Mini-Card-Stecker sind als Zubehdr erhdltlich. Bitte kontaktieren Sie hierfur lhren Distributor.
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Pinbelegung:

Beschreibung Name Pin Name Beschreibung
Versorgungsspannung 3,3V |3,3V 1 2 12V Versorgungsspannung 12V
Standby-Versorgung 3,3V S3,3V 3 4 SMBCLK1 |SMB Clock Slot 1
PCle Reset PLTPCIE# |5 6 SMBDAT1 |[SMB Dat Slot 1
Link Reactivation PEWAKE# [7 8 GND Masse
Masse GND 9 10 PECLKO PCle Clock 0 +
Transmit Lane 1 + PET1 11 12 PECLKO# PCle Clock O -

Transmit Lane 1 - PET1# 13 14 GND Masse

Masse GND 15 16 PER1 Receive Lane 1 +
Clock Enable 1 PE1CLKEN# |17 18 PER1# Receive Lane 1 -
Masse GND 19 20 GND Masse
Versorgungsspannung 3,3V |3,3V 21 22 12v Versorgungsspannung 12V
Standby-Versorgung 3,3V S3,3V 23 24 SMBCLK2 |SMB Clock Slot 2
PCle Reset PLTPCIE# |25 26 SMBDAT2 [SMB Dat Slot 2
Link Reactivation PEWAKE# |27 28 GND Masse

Masse GND 29 30 PECLK1 PCle Clock 1 +
Transmit Lane 2 + PET2 31 32 PECLK1# PCle Clock 1 -
Transmit Lane 2 - PET2# 33 34 GND Masse

Masse GND 35 36 PER2 Receive Lane 2 +
Clock Enable 2 PE2CLKEN# |37 38 PER2# Receive Lane 2 -
Masse GND 39 40 GND Masse
Versorgungsspannung 3,3V |3,3V 41 42 12V Versorgungsspannung 12V
Standby-Versorgung 3,3V S3,3V 43 44 SMBCLK3 |SMB Clock Slot 3
PCle Reset PLTPCIE# |45 46 SMBDAT4 |SMB Dat Slot 3
Link Reactivation PEWAKE# |47 48 GND Masse

Masse GND 49 50 PECLK2 PCle Clock 2 +
Transmit Lane 3 + PET3 51 52 PECLK2# PCle Clock 2 -
Transmit Lane 3 - PET3# 53 54 GND Masse
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Beschreibung Name Pin Name Beschreibung

Masse GND 55 56 PER3 Receive Lane 3 +

Clock Enable 3 PE3CLKEN# |57 58 PER3# Receive Lane 3 -

Masse GND 59 60 GND Masse

Versorgungsspannung 3,3V [3,3V 61 62 12V Versorgungsspannung 12V

Standby-Versorgung 3,3V S3,3V 63 64 SMBCLK4 |SMB Clock Slot 4

PCle Reset PLTPCIE# [65 66 SMBDAT4 |SMB Dat Slot 4

Link Reactivation PEWAKE# |67 68 GND Masse

Masse GND 69 70 PECLK3 PCle Clock 3 +

Transmit Lane 4 + PET4 71 72 PECLK3# PCle Clock 3 -

Transmit Lane 4 - PETA4# 73 74 GND Masse

Masse GND 75 76 PER4 Receive Lane 4 +

Clock Enable 4 PE3CLKEN# |77 78 PER4# Receive Lane 4 -

PCle Configure x1/x4 PECONF# [79 80 GND Masse

Beckhoff New Automation Technology CB3055
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3.15GPIO

Das Board verfiigt Gber eine General Purpose Input/Output-Schnittstelle, die tber einen 2x6poligen

Wannenstecker herausgefuhrt ist (FCl 98424-G52-12LF, passender Gegenstecker FCI 90311-012LF).
Durch entsprechende Programmierung des zugehdrigen Chips (PCA9535BS) kdnnen hier in sehr flexibler
Weise I/0-Funktionen angelegt werden. Erkundigen Sie sich bei Ihrem Distributor nach entsprechender

Software-Unterstiitzung.
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Pinbelegung GPIO-Stecker:

Beschreibung Name Pin Name Beschreibung
Versorgungsspannung 5V VCC 1 7 VCC Versorgungsspannung 5V
GP Input/Output 1 GPIO0 2 8 GPI104 GP Input/Output 5
GP Input/Output 2 GPIO1 3 9 GPIO5 GP Input/Output 6
GP Input/Output 3 GPIO2 4 10 GPIO6 GP Input/Output 7
GP Input/Output 4 GPIO3 5 11 GPIO7 GP Input/Output 8
Masse GND 6 12 GND Masse
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3.16Lufteranschlisse

An die Baugruppe kdnnen drei Lufter mit einer Versorgungsspannung von 12 Volt angeschlossen werden.
Dies geschieht Uiber einen 2x5poligen Wannenstecker (FCl 98424-G52-10LF, passender Gegenstecker
FCI 90311-010LF). Signale fiir die Uberwachung der Liifterdrehzahl sind ebenfalls vorhanden.
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Beschreibung Name Pin Name Beschreibung
Masse geregelt FANON1 1 6 FANON2 Masse geregelt
12V-Versorgung 12V 2 7 12V 12V-Versorgung
Fan 1 Tachosignal FANCTRL1 |3 8 FANCTRL2 |Fan 2 Tachosignal
12V-Versorgung 12v 4 9 FANCTRL3 [Fan 3 Tachosignal
Masse geregelt FANON3 5 10 GND Masse

Beckhoff New Automation Technology CB3055
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4 BIOS-Einstellungen

4.1 Benutzung des Setups

Innerhalb der einzelnen Setup-Seiten kdnnen jederzeit mit F2 (,Previous Values®) die zuletzt
abgespeicherten Einstellungen wieder hergestellt werden. Mit F3 (,Optimized Defaults®) werden werkseitig
festgelegte Standardwerte geladen. F2/F3 und auch F4 ("Save & Exit") laden bzw. sichern immer den
kompletten Satz an Einstellungen.

Ein ,» “-Zeichen vor dem Menlpunkt bedeutet, dass ein Untermenii vorhanden ist. Die Navigation von
einem Menupunkt zum anderen erfolgt mit Hilfe der Pfeiltasten, wobei mit der Enter-Taste der
entsprechende Menipunkt ausgewahlt wird, was dann z. B. den Aufruf eines Unterments oder eines
Auswabhldialogs bewirkt.

Zu jeder einzelnen Setup-Option wird oben rechts ein Hilfetext angezeigt, der in vielen Fallen nitzliche
Informationen zur Bedeutung der Option, zu erlaubten Werten usw., enhélt.

L HinwEls

Das BIOS wird regelmé&Rig weiterentwickelt, so dass die verfliigbaren Setup-Optionen sich jederzeit und
ohne gesonderte Mitteilung andern kdnnen. Dadurch kann es zu Abweichungen kommen zwischen den
tatsachlich vorhandenen Optionen und denen, die nachfolgend beschrieben werden. Zu beachten ist
aulBerdem, dass die in den Setup-MenUs im Folgenden gezeigten Einstellungen nicht notwendigerweise
die empfohlenen oder die Default-Einstellungen sind. Welche Einstellungen gewahlt werden mussen,
hangt jeweils vom Anwendungsszenario ab, in dem das Board betrieben wird.
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Main

4.2 Main

Aptio Setup Utility - Copyright

(C)

Kapitel: BIOS-Einstellungen

2012 American Megatrends, Inc.

MAIN Advanced Chipset Boot Security Save & Exit
Set the Date. Use Tab to
Board Information switch between Data elements.
Board CB3055
Revision 3
Bios Version 1.37
Processor Information
Name SandyBridge
Brand String Intel (R) Celeron(R) CPU
Frequency 1400 MHz
Processor ID 206a7
Stepping D2
Number of Processors 1Core(s) / 1Thread(s)
Microcode Revision 28 ——: Select Screen
GT Info GT1 (800 MHz) t1: Select Item
Enter: Select
IGFX VBIOS Version 2165 +/-: Change Opt.
Memory RC Version 1.2.2.0 Fl: General Help
Total Memory 4096 MB (DDR3) F2: Previous Values
Memory Frequency 1333 Mhz F3: Optimized Defaults
F4: Save & Exit
System Date [Mon 27/02/2014] ESC: Exit
System Time [00:47:04]
Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v' Board
Optionen: keine

v' Revision
Optionen: keine

v' Bios Version
Optionen: keine

v" Processor Information
Optionen: keine

v" Name
Optionen: keine

v' Brand String

Optionen: keine
v' Frequency
Optionen: keine
v" Processor ID
Optionen: keine
v' Stepping
Optionen: keine

v" Number of Processors
Optionen: keine

v' Microcode Revision
Optionen: keine

Beckhoff New Automation Technology CB3055
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v

GT Info
Optionen: keine

IGFX VBIOS Version
Optionen: keine

Memory RC Version
Optionen: keine

Total Memory
Optionen: keine

Memory Frequency
Optionen: keine

System Date

Main

Optionen: Hier kann das Systemdatum geéandert werden.

System Time

Optionen: Hier kann die Systemzeit geandert werden.

Seite 38
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Advanced

4.3 Advanced

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Main ADVANCED Chipset Boot Security Save & Exit

Kapitel: BIOS-Einstellungen

Power-Supply Type [ATX] Select the Type of the Power
SoftOff on Overheat [Disabled] Supply: AT/ATX
» PCI Subsystem Settings
» ACPI Settingstion
» CPU Configuration
» SATA Configuration
» Power Controller Options
» USB Configuration
» Super IO Configuration
» H/W Monitor
» Serial Port Console Redirection
» Network Stack
» CPU PPM Configuration
——: Select Screen
11: Select Item
» Intel(R) 82579LM Gigabit Network Connection - 88:88:88:8... Enter: Select
» Intel(R) 82574L Gigabit Network Connection - 00:01:05:17... +/-: Change Opt.
» Intel(R) 82574L Gigabit Network Connection - 00:01:05:17... Fl: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
ESC: Exit
Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.
v' Power-Supply Type
Optionen: ATX /AT
v' PCI Subsystem Settings
Untermenu: sieche "PCIl Subsystem Settings" (Seite 41)
v' ACPI Settings
Untermenu: siehe "ACPI Settings" (Seite 43)
v" CPU Configuration
Unterment: siehe "CPU Configuration" (Seite 44)
v" SATA Configuration
Unterment: siehe "SATA Configuration” (Seite 46)
v' Power Controller Options
Untermenu: sieche "Power Controller Options” (Seite 47)
v'USB Configuration
Unterment: siehe "USB Configuration” (Seite 49)
v' Super 10 Configuration
Untermenu: siehe "Super 10 Configuration" (Seite 50)
v H/W Monitor
Untermenu: siehe "H/W Monitor" (Seite 52)
v' Serial Port Console Redirection
Untermenti: siehe "Serial Port Console Redirection" (Seite 54)
v Network Stack

Untermend: siehe

"Network Stack" (Seite 56)

Beckhoff New Automation Technology CB3055
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v CPU PPM Configuration
Untermenu: siehe "CPU PPM Configuration” (Seite 57)

v Intel(R) Gigabit Network Connection
Untermenu: siehe "Intel(R) GigabitNetworkConnection" (Seite 58)
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4.3.1 PCIl Subsystem Settings

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced
PCI Bus Driver Version vV 2.05.02 Enables or Disables 64bit
capable Devices to be Decoded
in Above 4G Address Space
PCI 64bit Resources Handling (Only if System Supports 64
Above 4G Decoding [Disabled] bit PCI Decoding).

PCI Common Settings
PCI Latency Timer [32 PCI Bus Clocks]

» PCI Express Settings

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v Above 4G Decoding
Optionen: Enabled / Disabled

v' PCI Latency Timer
Optionen: 32, 64,...224, 248 PCI Bus Clocks

v PCI Express Settings
Untermenu: sieche "PCIl Express Settings" (Seite 42)
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4.3.1.1 PCIl Express Settings

Aptio Setup Utility - Copyright
Advanced

Advanced

(C) 2012 American Megatrends, Inc.

PCI Express Device Register Settings

WARNING: Enabling ASPM may cause some
PCI-E devices to fail

Relaxed Ordering [Disabled]
Extended Tag [Disabled]
No Snoop [Enabled]
Maximum Payload [Auto]
Maximum Read Request [Auto]

PCI Express Link Register Settings

ASPM Support [Disabled]

Extended Synch [Disabled]
Link Training Retry [5]

Link Training Timeout (uS) 100
Unpopulated Links [Disable]

Enables or Disables PCI
Express Device Relaxed
Ordering

Select Screen
Select Item

ol

R

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v" Relaxed Ordering
Optionen: Enabled / Disabled

v' Extended Tag

Optionen: Enabled / Disabled
v No Snoop
Optionen: Enabled / Disabled

v" Maximum Payload
Optionen:

v" Maximum Read Request
Optionen:

v' ASPM Support
Optionen: Disabled / Auto / Force LOs

v' Extended Synch
Optionen: Enabled / Disabled

v" Link Training Retry
Optionen: Disabled/2/3/5

v' Link Training Timeout (uS)
Optionen: 10...1000

v" Unpopulated Links
Optionen: Keep Link ON / Disable Link

Seite 42

Copyright (C)
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Auto / 128 Bytes / 256 Bytes / 512 Bytes / 1024 Bytes / 2048 Bytes / 4096 Bytes

Auto / 128 Bytes / 256 Bytes / 512 Bytes / 1024 Bytes / 2048 Bytes / 4096 Bytes
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4.3.2 ACPI Settings

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced
ACPI Settings Enables or Disables BIOS ACPI
Auto Configuration.
Enable ACPI Auto Configuration [Disabled]
Enable Hibernation [Enabled]
ACPI Sleep State [S1 only(CPU Stop Cl...]
Lock Legacy Resources [Disabled]

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v' Enable ACPI Auto Configuration
Optionen: Enabled / Disabled

v" Enable Hibernation
Optionen: Enabled / Disabled

v ACPI Sleep State
Optionen: Suspend Disabled / S1 (CPU Stop Clock)

v" Lock Legacy Resources
Optionen: Enabled / Disabled
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4.3.3 CPU Configuration

Aptio Setup Utility - Copyright

Advanced

(C)

2012 American Megatrends, Inc.

CPU Configuration

CPU Signature
Microcode Patch

Max CPU Speed

Min CPU Speed

CPU Speed

Processor Cores

Intel HT Technology
Intel VT-x Technology
Intel SMX Technology

Intel (R) Celeron(R) CPU 827E @ 1.4GHz

206a7
28

1400 MHz

800 MHz

1400 MHz

1

Not Supported

Supported

Not Supported

Disabled for Windows XP

64-bit Supported
L1 Data Cache 32 kB x 1
L1 Code Cache 32 kB x 1
L2 Cache 256 kB x 1 ——: Select Screen
L3 Cache 1536 kB tl: Select Item
Enter: Select

Limit CPUID Maximum [Disabled] +/-: Change Opt.
Execute Disable Bit [Enabled] Fl: General Help
Intel Virtualization Technology [Enabled] F2: Previous Values
TCC Activation Offset 0 F3: Optimized Defaults
Primary Plane Current value 0 F4: Save & Exit
Secondary Plane Current value 0 ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v' CPU Signature
Optionen: keine

v Microcode Patch
Optionen: keine

v Max CPU Speed
Optionen: keine

v Min CPU Speed

Optionen: keine
v' CPU Speed
Optionen: keine

v" Processor Cores
Optionen: keine

v' Intel HT Technology
Optionen: keine

v" Intel VT-x Technology
Optionen: keine

v" Intel SMX Technology

Optionen: keine
v’ 64-bit

Optionen: keine
v' L1 Data Cache

Optionen: keine
Seite 44
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v

Beckhoff New Automation Technology CB3055

L1 Code Cache
Optionen: keine

L2 Cache
Optionen: keine

L3 Cache
Optionen: keine

Limit CPUID Maximum
Optionen: Enabled / Disabled

Execute Disable Bit
Optionen: Enabled / Disabled

Intel Virtualization Technology
Optionen: Enabled / Disabled

TCC Activation Offset
Optionen: 0...15

Primary Plane Current value
Optionen: 0...255

Secondary Plane Current value
Optionen: 0...255

Kapitel: BIOS-Einstellungen
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4.3.4 SATA Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends,

Advanced

Inc.

SATA Controller(s)
SATA Mode Selection
SATA Test Mode
Alternate ID

Serial ATA Port 0
Software Preserve
Port O
Hot Plug
Spin Up Device

Serial ATA Port 1
Software Preserve
Port 1
Hot Plug
Spin Up Device

Serial ATA Port 2
Software Preserve
Port 2
Hot Plug
External SATA
Hot Plug
Spin Up Device

Serial ATA Port 3
Software Preserve
Port 3
Hot Plug
External SATA

[Enabled]
[RAID]
[Disabled]
[Disabled]
Empty
Unknown
[Enabled]
[Enabled]
[Disabled]
Empty
Unknown
[Enabled]
[Enabled]
[Disabled]
Empty
Unknown
[Enabled]
[Disabled]
[Disabled]
[Enabled]
[Disabled]
Empty
Unknown
[Enabled]
[Enabled]
[Disabled]

Enable or disable SATA Device.

F4:
ESC:

A
Tes
Enter:
+/-:
Fl:
F2:
F3:

Drive]
v

Select Screen
Select Item n
Select

Change Opt.
General Help
Previous Values
Optimized Defaults
Save & Exit

Exit

Version 2.15.1236.

SATA Controller(s)
Optionen: Enabled / Disabled

SATA Mode Selection
Optionen: IDE/ AHCI/RAID

SATA Test Mode

Optionen: Enabled / Disabled
Alternate ID

Optionen: Enabled / Disabled
Serial ATA Port X

Optionen: keine

Software Preserve

Optionen: keine

Port X

Optionen: Enabled / Disabled
Hot Plug

Optionen: Enabled / Disabled

External SATA
Optionen: Enabled / Disabled

Spin Up Device
Optionen: Enabled / Disabled
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4.3.5 Power Controller Options

Kapitel: BIOS-Einstellungen

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced

Bootloader Version
Firmware Version
Mainboard Serial No

Mainboard Prod. Date (Week.Year)

Mainboard BootCount
Mainboard Operation Time
Voltage (Min/Max)
Temperature (Min/Max)

ext. USB-Port Voltage
int. USB-Port Voltage

WatchDogTimer Mode
WDT OSBOOT Timeout

1.00-07

1.00-35
0948251130007

28.12

128

12090min (201h)
4.60V / 5.20V
18'C /51'C

[Off in S3-5]
[Off in S3-5]

[Normal Mode]
[Disabled]

Select Power line for external
USB devices, 1f powered-down

——: Select Screen

t11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

Bootloader Version
Optionen: keine

Firmware Version
Optionen: keine

Mainboard Serial No
Optionen: keine

Copyright (C) 2012 American Megatrends, Inc.

Mainboard Prod. Date (Week.Year)

Optionen: keine

Boot Count
Optionen: keine

Minute Meter
Optionen: keine

Voltage (Min/Max)
Optionen: keine

Temperature (Min/Max)
Optionen:  keine

ext. USB-Port Voltage

Optionen:  Off in S3-5/ by SVCC

int. USB-Port Voltage

Optionen:  Off in S3-5/ by SVCC

WatchDogTimer Mode

Optionen: Normal Mode / Compatibility Mode

Beckhoff New Automation Technology CB3055
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v WDT OSBoot Timeout
Optionen: Disabled / 45 Seconds ... 255 Seconds

Seite 48 Beckhoff New Automation Technology CB3055



Advanced Kapitel: BIOS-Einstellungen

4.3.6 USB Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced
USB Configuration Enables Legacy USB support.
AUTO option disables legacy
USB Devices: support if no USB devices are
1 Drive, 1 Keyboard, 1 Mouse connected. DISABLE option will
keep USB devices available
Legacy USB Support [Auto] only for EFI applications.
USB3.0 Support [Enabled]
XHCI Hand-off [Enabled]
EHCI Hand-off [Enabled]
USB hardware delays and time-outs:
USB transfer time-out 5 sec]
Device reset time-out 10 sec]

[
[
Device power-up delay [Manual] ——: Select Screen
Device power-up delay in seconds 5 t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v USB Devices
Optionen: keine

v' Legacy USB Support
Optionen: Enabled / Disabled / Auto

v USB3.0 Support
Optionen: Enabled / Disabled

v" XHCI Hand-off
Optionen: Enabled / Disabled

v' EHCI Hand-off
Optionen: Enabled / Disabled

v' USB transfer time-out
Optionen: 5 sec/ 10 sec/ 20 sec

v" Device reset time-out
Optionen: 10 sec/ 20 sec /30 sec /40 sec

v' Device power-up delay
Optionen:  Auto / Manual

v" Device power-up delay in seconds
Optionen: 1..40
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4.3.7 Super 10 Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced
Super IO Configuration Set Parameters of Serial Port
0 (CoMA)
Super IO Chip SMSC SCH3114

» Serial Port 0 Configuration
» Serial Port 1 Configuration

—<: Select Screen

tl: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v" Super IO Chip
Optionen: keine

v Serial Port X Configuration
Untermenu: siehe "Serial Port Configuration" (Seite 51)
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4.3.7.1 Serial Port Configuration

Kapitel: BIOS-Einstellungen

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced

Serial Port 0 Configuration

Serial Port [Enabled]
Device Settings IO=3F8h; IRQ=4;
Change Settings [Auto]

Device Mode [Normal]

Enable or Disable Serial Port
(COM)

——: Select Screen

11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v Serial Port
Optionen: Enabled / Disabled

v' Device Settings
Optionen: keine

v Change Settings
Optionen:  Auto/10=3F8h; IRQ=4/10=3F8h; IRQ=3,
...12 /10=2E8h; IRQ=3, ...12

v" Device Mode
Optionen: Normal / High Speed

Beckhoff New Automation Technology CB3055
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4.3.8 H/W Monitor

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced

H/W Monitor

CPU Temperature
Board Temperature
Memory Temperature
SYS FAN Speed

CPU FAN Speed
AUX FAN Speed
+1.05V

VccCore

+3.3V

Vcce

+12V

VTR

Vbat

ol

R

Select Screen
Select Item

Enter: Select

+/-:
Fl:
F2:
F3:
F4:
ESC:

Change Opt.
General Help
Previous Values
Optimized Defaults
Save & Exit

Exit

Version 2.15.1236.

v CPU Temperature
Optionen: keine

v Board Temperature
Optionen: keine

v Memory Temperature

Optionen: keine

v SYS FAN Speed
Optionen: keine

v CPU FAN Speed
Optionen: keine

v AUX FAN Speed
Optionen:  keine

v’ +1.05V
Optionen: keine

v" VccCore
Optionen:  keine

v +3.3V
Optionen: keine

v Vcc
Optionen: keine

v +12V
Optionen: keine
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v VTR
Optionen: keine

v' Vbat
Optionen: keine
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4.3.9 Serial Port Console Redirection

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced

COMO
Console Redirection
» Console Redirection

COM1
Console Redirection
» Console Redirection

[Enabled]
Settings

[Disabled]
Settings

Console Redirection Enable or
Disable.

ol

R

Fl:
F2:
F3:
F4:
ESC:

Select Screen
Select Item

Enter: Select
+/-:

Change Opt.
General Help
Previous Values
Optimized Defaults
Save & Exit

Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v' Console Redirection
Optionen: Enabled / Disabled

v' Console Redirection Settings

Untermend: siehe

Seite 54
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4.3.9.1 Console Redirection Settings

Kapitel: BIOS-Einstellungen

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Advanced
COMO Emulation: ANSI: Extended
Console Redirection Settings ASCII char set. VT100: ASCII
char set. VT100+: Extends
Terminal Type [VI-UTF8] VT100 to support color,
Bits per second [115200] function keys, etc. VT-UTF8:
Data Bits [8] Uses UTF8 encoding to map
Parity [None] Unicode chars onto 1 or more
Stop Bits [1] bytes.
Flow Control [None]
VT-UTF8 Combo Key Support [Enabled]
Recorder Mode [Disabled]
Resolution 100x31 [Enabled]
Legacy OS Redirection Resolution [80x24]
Putty KeyPad [VT100] ——: Select Screen
[

Redirection After BIOS POST

Always Enable]

11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C)

2012 American Megatrends,

v' Terminal Type
Optionen: VT100/VT100+/VT-UTF8/ ANSI
v' Bits per second
Optionen: 9600 / 19200 / 38400 / 57600 / 115200
v' Data Bits
Optionen: 7/8
v’ Parity
Optionen: None / Even/ Odd / Mark / Space
v' Stop Bits
Optionen: 1/2
v" Flow Control
Optionen:  None / Hardware RTS/CTS
v VT-UTF8 Combo Key Support
Optionen: Disabled / Enabled
v" Recorder Mode
Optionen: Disabled / Enabled
v" Resolution 100x31
Optionen: Disabled / Enabled
v' Legacy OS Redirection Resolution
Optionen:  80x24 / 80x25
v' Putty KeyPad

Optionen:

Beckhoff New Automation Technology CB3055

Inc.

VT100 / LINUX / XTERMR6 / SCO / ESCN / VT400
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4.3.10 Network Stack

Advanced

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced

Network stack
Ipv4 PXE Support
Ipv6e PXE Support

[Enable]
[Enable]
[Enable]

Enable/Disable UEFI network
stack

—<: Select Screen

tl: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v Network Stack

Optionen: Disabled / Enabled

v" Ipv4 PXE Support

Optionen: Disabled / Enabled

v" Ipv6 PXE Support

Optionen: Disabled / Enabled
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4.3.11 CPU PPM Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Advanced

CPU PPM Configuration Enable/Disable Intel SpeedStep

EIST
Config TDP LOCK

[Enabled]
[
Long duration power limit 0
1
0

Enabled]

Long duration maintained
Short duration power limit

——: Select Screen

t11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v EIST
Optionen: Disabled / Enabled

v" Config TDP LOCK
Optionen: Disabled / Enabled

v" Long duration power limit
Optionen:  0-255

v" Long duration power maintained
Optionen: 1-120

v" Short duration power limit
Optionen: 0-255
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4.3.12 Intel(R) GigabitNetworkConnection

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced
PORT CONFIGURATION MENU Click to configure the network
» NIC Configuration device port.
Blink LEDs 0

PORT CONFIGURATION INFORMATION

UEFI Driver: Intel (R) PRO/1000 5.7.06
Adapter PBA: FFFFFF-0FF

Chip Type Intel 1210

PCI Device ID 153A
Bus:Device:Function 00:19:00

Link Status [Disconnected]

MAC Address 88:88:88:88:87:88

—<: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v" NIC Configuration
Untermenti: siehe "NIC Configuration” (Seite 59)

v" Blink LEDs
Optionen: keine

v" UEFI Driver:
Optionen: keine

v' Adapter PBA:
Optionen: keine

v" Chip Type
Optionen: keine

v" PCI Device ID
Optionen:  keine

v PCI Bus:Device:Function
Optionen: keine

v' Link Status
Optionen:  keine

v" Factory MAC Adress
Optionen: keine
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4.3.12.1 NIC Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced
Link Speed [Auto Neg] Specifies the port speed used
Wake On LAN [Enabled] for the selected boot protocol.

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v' Link Speed
Optionen:  Auto Negotiated / 10Mbps Half / 10Mbps full / 100Mbps Half / 100Mbps Full

v" Wake On LAN
Optionen: Enabled / Disabled
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4.4 Chipset

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Main Advanced Chipset Boot Security Save & Exit

» PCH-IO Configuration System Agent (SA)
» System Agent (SA) Configuration

Parameters

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v" PCH-IO Configuration
Untermenu: sieche "PCH-IO Configuration" (Seite 61)

v' System Agent (SA) Configuration
Untermenu: siehe "System Agent (SA) Configuration" (Seite 68)
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4.4.1 PCH-IO Configuration

Kapitel: BIOS-Einstellungen

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset
Intel PCH RC Version 1.5.0.0 PCI Express Configuration
Intel PCH SKU Name QM67 settings
Intel PCH Rev ID 05/B3

» PCI Express Configuration
» USB Configuration
» PCH Azalia Configuration
PCH LAN Controller [Enabled]
LAN1 MAC address 88:88:88:88:87:88
Wake on LAN [Disabled]
Second LAN Controller [Enabled]

LAN2 MAC address
Third LAN Controller

00:01:05:17:11:B2
[SUS_PWR_DN_ACK]

LAN3 MAC address [Disabled]
Board Capability [Disabled]
CLKRUN# Logic [Disabled]
SB CRID

High Precision Event Timer Configuration
High Precision Timer [Enabled]

Restore AC Power Loss [Power On]

E

Select Screen
Select Item

Enter: Select

+/=:
Fl:
F2:
F3:
F4:
ESC:

Change Opt.
General Help
Previous Values
Optimized Defaults
Save & Exit

Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v" Intel PCH RC Version
Optionen: keine

v" Intel PCH SKU Name
Optionen: keine

v" Intel PCH Rev ID
Optionen: keine

v" PCI Express Configuration

Untermenu: siehe "PCI Express Configuration" (Seite 63)

v" USB Configuration
Unterment: siehe "USB Configuration" (Seite 66)

v" PCH Azalia Configuration

Untermenu: siehe "PCH Azalia Configuration" (Seite 67)

v PCH LAN Controller
Optionen: Disabled / Enabled

v" LAN1 MAC address
Optionen:  keine

v' Wake on LAN
Optionen: Disabled / Enabled

v" Second LAN Controller
Optionen: Disabled / Enabled

v" LAN2 MAC address
Optionen: keine

Beckhoff New Automation Technology CB3055
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v" Third LAN Controller
Optionen: Disabled / Enabled

v" LAN3 MAC address
Optionen: keine

v' Board Capability
Optionen: SUS PWR_DN_ACK / DeepSx

v CLKRUN# Logic
Optionen: Disabled

v SB CRID
Optionen: Disabled / Enabled

v" High Precision Timer
Optionen: Disabled / Enabled

v Restore AC Power Loss
Optionen: Power Off / Power On / Last State

Seite 62
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4.4.1.1 PCI Express Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Chipset

PCI Express Configuration Enable or disable PCI Express
Clock Gating for each root
PCI Express Clock Gating [Enabled] port.

DMI Link ASPM Control [Enabled]
DMI Link Extended Synch Control [Disabled]
PCIe-USB Glitch W/A [Disabled]
Subtractive Decode [Disabled]

PCI Express Root Port 1

PCI Express Root Port 2

PCI Express Root Port 3

PCI Express Root Port 4

PCIE Port 5 is assigned to LAN
PCIE Port 6 is assigned to LAN2 ——: Select Screen

PCIE Port 7 is assigned to PCIe to PCI Bridge t1: Select Item

» PCI Express Root Port 8 Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

vvyy

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v' PCI Express Clock Gating
Optionen: Disabled / Enabled

v" DMI Link ASPM Control
Optionen: Disabled / Enabled

v DMI Link Extended Synch Control
Optionen: Disabled / Enabled

v" PCle-USB Glitch W/A
Optionen: Disabled / Enabled

v' Subtractive Decode
Optionen: Disabled

v PCI Express Root Port X
Untermenu: siehe "PCI Express Settings" (Seite 64)
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4.41.1.1 PCIExpress Root Port

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset
PCI Express Root Port 2 [Enabled] Control the PCI Express Root
ASPM Support [Auto] Port.
URR [Disabled]
FER [Disabled]
NFER [Disabled]
CER [Disabled]
CTO [Disabled]
SEFE [Disabled]
SENFE [Disabled]
SECE [Disabled]
PME SCI [Enabled]
Hot Plug [Disabled]
PCIe Speed [Auto]
Extra Bus Reserved 0 —<: Select Screen
Reserved Memory 10 t1: Select Item
Prefetchable Memory 10 Enter: Select
Reserved I/0 4 +/-: Change Opt.
Fl: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v" PCI Express Root Port x
Optionen: Disabled / Enabled

v ASPM Support
Optionen: Disabled / LOs /L1 /L0sL1/Auto

v URR
Optionen: Disabled / Enabled

v FER
Optionen: Disabled / Enabled

v" NFER
Optionen: Disabled / Enabled

v CER
Optionen: Disabled / Enabled

v CTO
Optionen: Disabled / Enabled

v SEFE
Optionen: Disabled / Enabled

v SENFE
Optionen: Disabled / Enabled

v SECE
Optionen: Disabled / Enabled

v" PME SCI
Optionen: Disabled / Enabled
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Hot Plug
Optionen: Disabled / Enabled

PCle Speed
Optionen: Auto/ Genl/ Gen2

Extra Bus Reserved
Optionen: 0...7

Reserved Memory
Optionen: 1...20

Prefetchable Memory
Optionen: 1...20

Reserved /O
Optionen: 4/8/12/16/20

Kapitel: BIOS-Einstellungen
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4.4.1.2 USB Configuration

Aptio Setup Utility - Copyright (C)

Chipset

2012 American Megatrends, Inc.

USB Configuration

EHCI1 [Enabled]
EHCI2 [Enabled]
USB Ports Per-Port Disable Control [Enabled]
USB Port #0 Disable [Enabled]
USB Port #1 Disable [Enabled]
USB Port #2 Disable [Enabled]
USB Poer #3 Disable [Enabled]
USB Port #4 Disable [Enabled]
USB Port #5 Disable [Enabled]
USB Port #6 Disable [Enabled]
USB Port #7 Disable [Enabled]
USB Port #8 Disable [Enabled]
USB Port #9 Disable [Enabled]
USB Port #10 Disable [Enabled]
USB Port #11 Disable [Enabled]

Control each of the USB ports
(0~13) disabling.

—<: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright

EHCI1
Optionen: Enabled

EHCI2
Optionen: Enabled

USB Ports Per-Port Disable Control
Optionen: Disabled / Enabled

USB Port #x Disable
Optionen: Disabled / Enabled

Seite 66
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4.4.1.3 PCH Azalia Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset
PCH Azalia Configuration Control Detection of the
Azalia device.

Azalia [Auto] Disabled = Azalia will be
Azalia PME [Disabled] unconditionally disabled
Azalia Internal HDMI Codec [Enabled] Enabled = Azalia will be

Azalia HDMI codec Port B [Disabled] unconditionally Enabled
Azalia HDMI codec Port C [Disabled] Auto = Azalia will be enabled
Azalia HDMI codec Port D [Enabled] if present, disabled otherwise.

——: Select Screen

11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v Azalia
Optionen: Disabled / Enabled / Auto

v' Azalia PME
Optionen: Disabled / Enabled

v' Azalia Internal HDMI Codec
Optionen: Disabled / Enabled

v" Azalia HDMI codec Port X
Optionen: Disabled / Enabled
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Chipset

4.4.2 System Agent (SA) Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset

System Agent Bridge Name
System Agent RC Version

CHAP Device (B0:D7:F0)
Thermal Device (B0:D4:F0)
Enable NB CRID

BDAT ACPI Table Support

» Graphics Configuration
» NB PCIe Configuration

SandyBridge
1.5.0.0

[Disabled]
[Disabled]
[Disabled]
[Disabled]

Enabled or disable SA CHAP
Device.

—<: Select Screen

tl: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v' System Agent Bridge Name

Optionen: keine

v' System Agent RC Version
Optionen: keine

v" CHAP Device (B0:D7:FO0)

Optionen: Disabled / Enabled

v" Thermal Device (B0:D4:F0)

Optionen: Disabled / Enabled

v Enable NB CRID

Optionen: Disabled / Enabled

v BDAT ACPI Table Support

Optionen: Disabled / Enabled

v C-State Pre-Wake

Optionen: Disabled / Enabled

v' Graphics Configuration

Copyright (C)

2012 American Megatrends, Inc.

Unterment: siehe "Graphics Configuration” (Seite 69)

v NB PCle Configuration

Untermenu: sieche "NB PCle Configuration" (Seite 71)

Seite 68

Beckhoff New Automation Technology CB3055



Chipset Kapitel: BIOS-Einstellungen

4.4.2.1 Graphics Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset
Graphics Configuration Graphics turbo IMON current
IGFX VBIOS Version 2137 values supported (14-31)
IGfx Frequency 650 MHz
Graphics Turbo IMON Current 31
Primary Display [Auto]
Internal Graphics [Auto]
GTT Size [2MB]
Aperture Size [256MB]
DVMT Pre-Allocated [64M]
DVMT Total Gfx Mem [256M]
Gfx Low Power Mode [Disabled]

» LCD Control

——: Select Screen

11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v IGFX VBIOS Version
Optionen: keine

v IGFX Frequency
Optionen: keine

v" Graphics Turbo IMON Current
Optionen: 14...31

v' Primary Display
Optionen: Auto / IGFX / PEG / PCI

v" Internal Graphics
Optionen: Auto / Disabled / Enabled

v GTT Size
Optionen: 1MB/2MB

v' Aperture Size
Optionen: 128MB/ 256MB /512MB

v' DVMT Pre-Allocated
Optionen:  32M/ 64M ... 480M / 512M / 1024M

v DVMT Total Gfx Mem
Optionen: 128M / 256M / MAX

v' Gfx Low Power Mode
Optionen: Disabled / Enabled

v" LCD Control
Untermenu: siehe "LCD Control" (Seite 70)
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44211 LCD

Control

Aptio Setup Utility - Copyright
Chipset

(C) 2012 American

Megatrends, Inc.

LCD Control

Primary IGFX B
Secondary IGFEX
LCD Panel Type
Spread Spectru
ALS Support

oot Display
Boot Display

CRT]

m clock Chip Off]

[
[Disabled]
[VBIOS Default]
[

[

Disabled]

Select the Video Device which
will be activated during POST.
This has no effect if external
graphics present.

Secondary boot display
selection will appear based on
your selection.

VGA modes will be supported
only on primary display

—: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v" Primary IGFX Boot Display
VBIOS Default/ CRT / EFP / LFP / EFP3 / EFP2 / LFP2

Optionen:

v" Secondary IGFX Boot Display
VBIOS Default/ CRT / EFP / LFP / EFP3 / EFP2 / LFP2

Optionen:

v' LCD Panel Type
VBIOS Default / 640x480 LVDS ...1920x1080 LVDS / 2048x1536 LVDS

Optionen:

v' Spread Spe
Optionen:

ctrum Clock Chip
Off / Hardware / Software

v" ALS Support

Optionen:

Seite 70

Disabled / Enabled

Copyright (C)

2012 American Megatrends,

Inc.
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4.4.2.2 NB PCle Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset
Configure PEGO BO:D1:FO

PEGO Not Present Genl-Gen3

PEGO - Gen X [Auto]

PEGO ASPM [Auto]
Enable PEG [Auto]
Detect Non-Compliance Device [Disabled]
De-Emphasis Control [-3.5 dB]
PEG Sampler Calibrate [Auto]
Swing Control [Full]
Gen3 Equalization [Enabled]

Gen3 Eg Phase 2 [Disabled]

I A A N >

» PEG Gen3 Root Port Preset Value for each Lane ——: Select Screen
» PEG Gen3 Endpoint Preset Value each Lane t1: Select Item
» PEG Gen3 Endpoint Hint Value each Lane Enter: Select
Gen3 Eg Preset Search [Enabled] +/-: Change Opt.
Always re-search Gen3 Eg Preset [Disabled] Fl: General Help
Preset Search Dwell Time 100 F2: Previous Values
Timing Margin Steps 2 F3: Optimized Defaults
Timing Start Margin 15 F4: Save & Exit
Voltage Margin Steps 2 ESC: Exit
Voltage Start Margin 20
Favor Timing Margin [Disabled]
PEG Link Disabled [Disabled]
Fast PEG Init [Enabled] v

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v PEGn - Gen X
Optionen: Auto/ Genl/ Gen2/ Gen3

v PEGn ASPM
Optionen: Disabled / Auto / ASPM LOs / ASPM L1/ ASPM LOsL1

v Enable PEG
Optionen: Disabled / Enabled / Auto

v" Detect Non-Compliance Device
Optionen: Disabled / Enabled

v' De-emphasis Control
Optionen: -6dB/-3.5dB

v' PEG Sampler Calibrate
Optionen:  Auto / Disabled / Enabled

v" Swing Control
Optionen: Reduced / Half / Full

v Gen3 Equalization
Optionen: Disabled / Enabled

v Gen3 Eq Phase 2
Optionen:  Auto / Enabled / Disabled

v" Gen3 Root Port Preset Value for each Lane
Untermenu: siehe "PEG Gen3 Root Port Preset Value for each Lane" (Seite 73)

v PEG Gen3 Endpoint Preset Value for each Lane
Untermenu: sieche "PEG Gen3 Endpoint Preset Value each Lane" (Seite 74)
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v PEG Gen3 Endpoint Hint Value for each Lane
Untermenu: siehe "PEG Gen3 Endpoint Hint Value each Lane" (Seite 75)

v Gen3 Eq Preset Search
Optionen: Enabled / Disabled

v' Always re-search Gen3 Eq Preset
Optionen: Enabled / Disabled

v Preset Search Dwell Time
Optionen: 0-65535

v Timing Margin Steps
Optionen:  1-255

v Timing Start Margin
Optionen:  4-255

v" Voltage Margin Steps
Optionen:  1-255

v" Voltage Start Margin
Optionen: 4-255

v' Favor Timing Margin
Optionen: Enabled / Disabled

v" PEG Link Disabled
Optionen: Disabled / Enabled

v' Fast PEG Init
Optionen: Disabled / Enabled

v RXCEM Loop back
Optionen: Disabled / Enabled

v RXCEM Loop back lane
Optionen: Lane 0...15

v" PCle Gen3 RxCTLEp Setting
Optionen: 0...15
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4.42.21 PEG Gen3 Root Port Preset Value for each Lane

Aptio Setup Utility - Copyright

(C)

2012 American Megatrends, Inc.

v" Gen3 Root Port Preset Value for each Lane
Optionen:

1.11

Chipset
PEG Gen3 Root Port Preset Value for each Lane Lane 0 Root port preset value

for Gen3 Equalization.

Gen3 Root Port Preset Lane 0 8

Gen3 Root Port Preset Lane 1 8

Gen3 Root Port Preset Lane 2 8

Gen3 Root Port Preset Lane 3 8

Gen3 Root Port Preset Lane 4 8

Gen3 Root Port Preset Lane 5 8

Gen3 Root Port Preset Lane 6 8

Gen3 Root Port Preset Lane 7 8

Gen3 Root Port Preset Lane 8 8

Gen3 Root Port Preset Lane 9 8

Gen3 Root Port Preset Lane 10 8

Gen3 Root Port Preset Lane 11 8 ——: Select Screen

Gen3 Root Port Preset Lane 12 8 t1: Select Item

Gen3 Root Port Preset Lane 13 8 Enter: Select

Gen3 Root Port Preset Lane 14 8 +/-: Change Opt.

Gen3 Root Port Preset Lane 15 8 Fl: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.
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Chipset

4.4.2.2.2 PEG Gen3 Endpoint Preset Value each Lane

v' Gen3 Endpoint Preset Value each Lane
Optionen:

0.11

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Chipset
PEG Gen3 Endpoint Preset Value each Lane Lane 0 End point preset value

for Gen3 Equalization.

Gen3 Root Port Preset Lane 0 7

Gen3 Root Port Preset Lane 1 7

Gen3 Root Port Preset Lane 2 7

Gen3 Root Port Preset Lane 3 7

Gen3 Root Port Preset Lane 4 7

Gen3 Root Port Preset Lane 5 7

Gen3 Root Port Preset Lane 6 7

Gen3 Root Port Preset Lane 7 7

Gen3 Root Port Preset Lane 8 7

Gen3 Root Port Preset Lane 9 7

Gen3 Root Port Preset Lane 10 7

Gen3 Root Port Preset Lane 11 7 ——: Select Screen

Gen3 Root Port Preset Lane 12 7 t1: Select Item

Gen3 Root Port Preset Lane 13 7 Enter: Select

Gen3 Root Port Preset Lane 14 7 +/-: Change Opt.

Gen3 Root Port Preset Lane 15 7 Fl: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.
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4.4.2.2.3 PEG Gen3 Endpoint Hint Value each Lane

Aptio Setup Utility - Copyright

Chipset

(C) 2012 American Megatrends, Inc.

PEG

Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3

Gen3

Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root

Endpoint Hint Value each Lane

Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port

Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset

Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane

W JoNUsWN PO

NDNONNDDNDNDDNDNDDNDNDNDNDNDNDNDND

for

Lane 0 End Point Hint value

Gen3 Equalization.

e

Fl:
F2:
F3:
F4:

ESC:

Select Screen
Select Item

Enter: Select
+/=:

Change Opt.
General Help
Previous Values
Optimized Defaults
Save & Exit

Exit

Version 2.15.1236. Copyright

(C)

2012 American Megatrends, Inc.

v PEG Gen3 Endpoint Hint Value each Lane
Optionen:

0.11

Beckhoff New Automation Technology CB3055
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Chipset

4.42.2.4 PCle Gen3 RxCTLEp Setting

Aptio Setup Utility - Copyright

Chipset

()

2012 American

Megatrends, Inc.

PCIe Gen3 RxCTLEp Setting

Select the Video Device which
will be activated during POST.

PCIe Gen3 RxCTLEp Setting 0 8 This has no effect if external
PCIe Gen3 RxCTLEp Setting 1 8 graphics present.
PCIe Gen3 RxCTLEp Setting 2 8 Secondary boot display
PCIe Gen3 RxCTLEp Setting 3 8 selection will appear based on
PCIe Gen3 RxCTLEp Setting 4 8 your selection.
PCIe Gen3 RxCTLEp Setting 5 8 VGA modes will be supported
PCIe Gen3 RxCTLEp Setting 6 8 only on primary display
PCIe Gen3 RxCTLEp Setting 7 8
—<: Select Screen
t1: Select Item
Enter: Select
+/-: Change Opt.
Fl: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
ESC: Exit
Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v" PCle Gen3 RXxCTLEp Setting x

Optionen: 0..15

Seite 76
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4.5 Boot

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Main Advanced Chipset Boot Security Save & Exit

Boot Configuration Number of 1/10 sec. to wait
Setup Prompt Timeout 5 for setup activation key. 0
Bootup NumLock State [On] means no wait.
Full Screen Logo [Enabled]
Fast Boot [Enabled]

Skip VGA [Disabled]

Skip USB [Disabled]

Skip PS2 [Disabled]
CSM16 Module Version 07.69
GateA20 Active [Upon Request]
INT19 Trap Response [Postponed] ——: Select Screen
Boot mode select [UEFI] 11: Select Item

Enter: Select

FIXED BOOT ORDER Priorities +/-: Change Opt.
Boot Option #1 [UEFI Hard Disk] Fl: General Help
Boot Option #2 [UEFI CD/DVD] F2: Previous Values
Boot Option #3 [UEFI USB Hard Disk] F3: Optimized Defaults
Boot Option #4 [UEFI USB CD/DVD] F4: Save & Exit
Boot Option #5 [UEFI USB Stick] ESC: Exit
Boot Option #6 [UEFI USB Floppy]
Boot Option #7 [UEFI Network]

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v/ Setup Prompt Timeout
Optionen:  0...65535 [x 1/10 sec.]

v' Bootup NumLock State
Optionen:  On/ Off

v" Full Screen Logo
Optionen: Disabled / Enabled

v" Fast Boot
Optionen: Disabled / Enabled

v' Skip VGA
Optionen: Disabled / Enabled

v' Skip USB
Optionen: Disabled / Enabled

v' Skip PS2
Optionen: Disabled / Enabled

v" CSM16 Module Version
Optionen: keine

v GateA20 Active
Optionen:  Upon Request / Always

v" INT9 Trap Response
Optionen: Immediate / Postponed

v Boot mode select
Optionen: Legacy / UEFI/ DUAL
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v Fixed Boot Order Priorities
Optionen: Reihenfolge der Boot-Devices tberprufen/andern

v' Boot Option Priorities
Optionen: Reihenfolge der Boot-Devices tberprifen/andern

v CSM Parameters
Untermenu: siehe "CSM Parameters"” (Seite 79)
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451 CSM Parameters

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Main Advanced Chipset BOOT Security Save & Exit

Launch CSM [Always] Controls the execution of UEFI
Boot option filter [UEFI only] and Legacy PXE OpROM

Launch PXE OpROM policy [Enable]

Launch Storage OpROM policy [Legacy only]
Launch Video OpROM policy [Legacy only]

Other PCI device ROM priority [Legacy OpROM]

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v Launch CSM
Optionen: Enabled / Disabled

v' Boot option filter
Optionen: UEFI and Legacy / Legacy only / UEFI only

v" Launch PXE OpROM policy
Optionen: Disable / Enable

v' Launch Storage OpROM policy
Optionen: Do not launch / UEFI only / Legacy only

v" Launch Video OpROM policy
Optionen: Do not launch / UEFI only / Legacy only

v' Other PCI device ROM priority
Optionen: UEFI OpROM / Legacy OpROM
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4.6 Security

Aptio Setup Utility - Copyright (C) 2012 American

Main Advanced Chipset

Boot

Security Save & Exit

Megatrends, Inc.

The password length must be
in the following range:
Minimum length

Maximum length

Administrator Password

UEFI Secure Boot Management
Secure Boot control

» Secure Boot Policy

» Key Management

[Enabled]

Set Administrator Password.
When set, this password has to
be entered to enter setup

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v Administrator Password
Optionen:

v Secure Boot control
Optionen:

v" Secure Boot Policy
Untermenii: siehe

v' Key Management
Untermend: siehe

Seite 80

Eingabetaste driicken

Disabled / Enabled

"Secure Boot Policy" (Seite 81)

"Key Management” (Seite 82)

Security

Beckhoff New Automation Technology CB3055



Security

4.6.1 Secure Boot Policy

Aptio Setup Utility - Copyright (C)

2012 American
Security

Kapitel: BIOS-Einstellungen

Megatrends, Inc.

Internal FV
Option ROM
Removable Media
Fixed Media

Always Execute]
Deny Execute]
Deny Execute]
Deny Execute]

[
[
[
[

Image Execution Policy on
Security Violation. Image load
device path

——: Select Screen

t11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v' Internal FV
Optionen: Always Execute

v Option ROM
Optionen:
User

v" Removable Media
Optionen:
User

v Fixed Media
Optionen:
User

Copyright (C)

Beckhoff New Automation Technology CB3055

2012 American Megatrends, Inc.

Always Execute / Always Deny / Allow Execute / Defer Execute / Deny Execute / Query

Always Execute / Always Deny / Allow Execute / Defer Execute / Deny Execute / Query

Always Execute / Always Deny / Allow Execute / Defer Execute / Deny Execute / Query
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4.6.2 Key Management

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Security
System Mode Setup Launches the Filebrowser to
Secure Boot Mode Disabled set the Platform Key from file
Platform Key (PK) NOT INSTALLED
» Set PK from File
» Get PK to File
» Delete the PK
Key Exchange Key Database (KEK) NOT INSTALLED
» Set KEK from File
» Get KEK to File
» Delete the KEK
» Append an entry to KEK
Authorized Signature Database (DB) NOT INSTALLED
» Set DB from File —<: Select Screen
» Get DB to File tl: Select Item
» Delete the DB Enter: Select
» Append an entry to DB +/-: Change Opt.
Forbidden Signature Database (DBX) NOT INSTALLED Fl: General Help
» Set DBX from File F2: Previous Values
» Get DBX to File F3: Optimized Defaults
» Delete the DBX F4: Save & Exit
» Append an entry to DBX ESC: Exit
Manage All Factory Keys (PK,KEK, DB, DBX)
Install Factory Defaults

Version 2.15.1236.

v' System Mode
Optionen: keine

v Secure Boot Mode
Optionen: keine

v Set PK from File

Copyright (C)

Optionen: Eingabetaste driicken

v Get PK to File

Optionen: Eingabetaste driicken

v" Delete the PK

Optionen: Eingabetaste driicken

v Set KEK from File

Optionen: Eingabetaste driicken

v" Get KEK to File

Optionen: Eingabetaste driicken

v Delete the KEK

Optionen:  Eingabetaste driicken

v" Append an entry to KEK

Optionen: Eingabetaste driicken

v Set DB from File

Optionen: Eingabetaste driicken

v Get DB to File

Optionen: Eingabetaste driicken
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Delete the DB
Optionen:  Eingabetaste driicken

Append an entry to DB
Optionen: Eingabetaste driicken

Set DBX from File
Optionen: Eingabetaste driicken

Get DBX to File
Optionen: Eingabetaste driicken

Delete the DBX
Optionen:  Eingabetaste driicken

Append an entry to DBX
Optionen:  Eingabetaste driicken

Install Factory Defaults
Optionen: Eingabetaste driicken

Kapitel: BIOS-Einstellungen
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4.7 Save & Exit

Aptio Setup Utility - Copyright
Main Advanced Chipset Boot Security Save

Save & Exit

(C) 2012 American Megatrends, Inc.
& Exit

Save Changes and Reset
Discard Changes and Reset

Restore Optimized Defaults
Save as User Defaults
Restore User Defaults

Boot Override
IBA GE Slot 00C8 v1381

Reset the system after saving
the changes.

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v' Save Changes and Reset

Copyright (C)

Optionen: Eingabetaste driicken

v" Discard Changes and Reset

Optionen: Eingabetaste driicken

v Restore Defaults

Optionen: Eingabetaste driicken

v" Save as User Defaults

Optionen: Eingabetaste driicken

v Restore User Defaults

Optionen: Eingabetaste driicken

v" Boot Override

Optionen: Eingabetaste driicken

v" IBA GE Slot 00C8 v1381
Optionen: keine
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4.8 BIOS-Update

Wenn ein Update des BIOS vorgenommen werden soll, dann wird hierzu das Programm ,DecdFlsh*
sowie ein bootfahiges Medium mit der aktuellsten BIOS-Version benutzt. Dabei ist es wichtig, dass das
Programm aus einer DOS-Umgebung ohne einen virtuellen Speichermanager wie zum Beispiel
LEMM386.EXE" gestartet wird. Sollte ein solcher Speichermanager geladen sein, wird das Programm mit
einer Fehlermeldung abbrechen oder einen Absturz verursachen.

DecdFlsh ist ein Programm zum automatischen Update des BIOS auf allen Boards mit AMI-BIOS. Alle
Dateien aus dem zip-Verzeichnis miissen in ein Verzeichnis entpackt werden. Von dort wird

DecdFlsh Bios-Dateiname

aufgerufen. Der Name der BIOS-Datei und deren Lange werden tberprift. Das BIOS wird nun
programmiert.

Wahrend des Flash-Vorgangs darf das System auf keinen Fall unterbrochen werden, da sonst das Update
abbricht und anschlieRend das BIOS auf dem Board zerstort ist. Der Flash-Vorgang dauert etwa 75
Sekunden. Das erforderliche Firmware-Update erfolgt automatisch.

A ACHTUNG

Wenn das BIOS-Update fehlerhaft durchgefiihrt wird, kann das Board dadurch unbenutzbar werden.
Deshalb sollte ein BIOS-Update nur gemacht werden, wenn die Korrekturen/Ergéanzungen, die die neue
BIOS-Version mitbringt, auch wirklich benétigt werden.

A ACHTUNG

Vor einem geplanten BIOS-Update muss unbedingt sichergestellt werden, dass die BIOS-Datei, die neu
eingespielt werden soll, wirklich fir genau dieses Board und fiir genau diese Boardversion herausgegeben
wurde. Wenn eine ungeeignete Datei verwendet wird, dann fuhrt dies unweigerlich dazu, dass das Board
anschlieend nicht mehr startet.
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5 Mechanische Zeichnung

5.1 Leiterplatte: Bohrungen

HINWEIS

Alle MaRangaben sind in mil (1 mil = 0,0254 mm)

LLT=PuT3eTd 90T=TTITad :LH-GH S®TOH
0§z=buT3ieTd 9gT=TTTIQ :yH-TH SOTCH
[ur] TTW = UOTSULWTA

0€9S

E€LYS

(0/0) wm3eq
2ouaiagay

2011

7H

9SLeT

©

@)

CH

@o

00000000 (O (O

(@ )@

000°
oo@

©

%
()(:>
©
©
©
©

©

Be000 @©O0O0O0O @@@@@@@@@@@@

00000 00000

Q00
[efeTe)

Q

786

80TT

910%

00 0 0 [eNe] o0 AMW/
o ° 3
@/ A A
Z N> Y/
LH 9H SH
QO @)e) @)
TH
o © ﬂ
§C1¢C G121

GLTZ

ELVS

0€9S

L8LS

Beckhoff New Automation Technology CB3055

Seite 86



Seite 87

Kapitel: Mechanische Zeichnung

Leiterplatte: Pin-1-Abstande

Pin-1-Abstande

5.2 Leiterplatte

HINWEIS

- —

Alle MalR3angaben sind in mil (1 mil = 0,0254 mm)
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5.3 Leiterplatte: Heat Sink

HINWEIS

Leiterplatte: Heat Sink

Alle Maf3angaben sind in mil (1 mil = 0,0254 mm)
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6 Technische Daten

6.1 Elektrische Daten

Spannungsversorgung:
Board:
RTC:
Stromverbrauch:
RTC:

6.2 Umgebungsbedingungen

Temperaturbereich:
Operating:
Lagerung:
Versand:

Temperaturanderungen:
Operating:
Lagerung:
Versand:

Relative Luftfeuchte:
Operating:
Lagerung:
Versand:

Stol3:
Operating:
Lagerung:
Versand:

Vibrationen:
Operating:

Lagerung:

Versand:

A ACHTUNG

Kapitel: Technische Daten

5 Volt +/- 5% (5 Volt Suspend, 12 Volt Lufter)
>= 3 Volt

<= 10pA

0°C bis +60°C (erw. Temperaturbereich auf Anfrage)
-25°C bis +85°C
-25°C bis +85°C, fur verpackte Boards

0,5°C pro Minute, 7,5°C in 30 Minuten
1,0°C pro Minute
1,0°C pro Minute, fur verpackte Boards

5% bis 85% (nicht kondensierend)
5% bis 95% (nicht kondensierend)
5% bis 100% (nicht kondensierend), fir verpackte Boards

150m/s?, 6ms
400m/s’, 6ms
400m/s?, 6ms, fir verpackte Boards

10 bis 58Hz, 0,075mm Amplitude

58 bis 500Hz, 10m/s’

5 bis 9Hz, 3,5mm Amplitude

9 bis 500Hz, 10m/s’

5 bis 9Hz, 3,5mm Amplitude

9 bis 500Hz, 10m/s?, fiir verpackte Boards

Die Angaben zu StoRR- und Vibrationsfestigkeit beziehen sich auf das reine Motherboard ohne Kiihlkdrper,

Speicherriegel, Verkabelungen usw.

Beckhoff New Automation Technology CB3055
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6.3 Thermische Spezifikationen

Das Board ist spezifiziert fur einen Umgebungstemperaturbereich von 0°C bis +60°C (erw.
Temperaturbereich auf Anfrage). Zusétzlich muss darauf geachtet werden, dass die Temperatur des
Prozessor-Dies 100°C nicht Uberschreitet. Hierfir muss ein geeignetes Kihlkonzept realisiert werden, das
sich an der maximalen Leistungsaufnahme des Prozessors/Chipsatzes orientiert. Zu beachten ist dabei
auch, dass eventuell vorhandene Kontroller im Kihlkonzept Beriicksichtigung finden. Die
Leistungsaufnahme dieser Bausteine liegt unter Umstanden in der gleichen GréRenordnung wie die
Leistungsaufnahme des stromsparenden Prozessors.

Das Board ist durch geeignete Bohrungen fur den Einsatz moderner Kiihl-Losungen vorbereitet. Wir haben
eine Reihe von kompatiblen Kiihl-Komponenten im Programm. Ihr Distributor berét Sie gerne bei der
Auswahl geeigneter Lésungen.

A ACHTUNG

Es liegt im Verantwortungsbereich des Endkunden, dass die Die-Temperatur des Prozessors 100°C nicht
tiberschreitet! Eine dauerhafte Uberhitzung kann das Board zerstoren!

Fur den Fall, dass die Temperatur 100°C tberschreitet, muss die Umgebungstemperatur reduziert werden.
Unter Umstanden muss flr eine ausreichende Luftzirkulation Sorge getragen werden.
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7 Support und Service

Beckhoff und seine weltweiten Partnerfirmen bieten einen umfassenden Support und Service, der eine
schnelle und kompetente Unterstiitzung bei allen Fragen zu Beckhoff-Produkten und -Systemlésungen zur
Verfugung stellt.

7.1 Beckhoff-Support

Der Support bietet Ihnen einen umfangreichen technischen Support, der Sie nicht nur bei dem Einsatz
einzelner Beckhoff-Produkte, sondern auch bei weiteren umfassenden Dienstleistungen unterstitzt:

o weltweiter Support
o Planung, Programmierung und Inbetriebnahme komplexer Automatisierungssysteme
o umfangreiches Schulungsprogramm fiir Beckhoff-Systemkomponenten

Hotline: +49(0)5246/963-157
Fax: +49(0)5246/963-9157
E-Mail: support@beckhoff.com

7.2 Beckhoff-Service

Das Beckhoff-Service-Center unterstiitzt Sie rund um den After-Sales-Service:

Vor-Ort-Service
Reparaturservice
Ersatzteilservice
Hotline-Service

Hotline: +49(0)5246/963-460
Fax: +49(0)5246/963-479
E-Mail: service@beckhoff.com

@)
@)
@)
@)

7.3 Beckhoff-Firmenzentrale
Beckhoff Automation GmbH

Eiserstr. 5

33415 Verl

Deutschland
Telefon: +49(0)5246/963-0
Fax: +49(0)5246/963-198
E-Mail: info@beckhoff.de
Web www.beckhoff.de

Weitere Support- und Serviceadressen finden Sie auf unseren Internetseiten unter http://www.beckhoff.de.
Dort finden Sie auch weitere Dokumentationen zu Beckhoff-Komponenten.
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| Anhang: Post-Codes

Wahrend der Bootphase generiert das BIOS eine Reihe von Statusmeldungen (sog. "POST-Codes"), die
mit Hilfe eines geeigneten Lesegerates (POST-Code-Karte) ausgegeben werden kénnen. Die Bedeutung
der POST-Codes wird in dem Dokument "Aptio™ 4.x Status Codes" von American Megatrends® erldutert,
das auf der Webseite http://www.ami.com erhaltlich ist. Zusatzlich werden die folgenden
OEM-POST-Codes ausgegeben:

Code Beschreibung
87h BIOS-API gestartet

88h PCA9535 gestartet

89h PWRCTRL-Firmware gestartet
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Il Anhang: Ressourcen

|IO-Bereich

Die verwendeten Ressourcen sind abhéngig von der Setup-Einstellung.

Bei den aufgefiihrten Bereichen handelt es sich um feststehende 10-Bereiche die durch AT-Kompatibilitat
gegeben sind. Es werden weitere 10-Bereiche benutzt, die durch die Plug&Play-Funktion des BIOS
wahrend der Boot-Phase dynamisch vergeben werden.

Adresse Funktion
0-FF Reservierter |0-Bereich fiir das Board
170-17F
1F0-1F7
278-27F
2E8-2EF COM4
2F8-2FF COM2
370-377
378-37F
3BC-3BF
3E8-3EF COM3
3F0-3F7
3F8-3FF COM1

Memory-Bereich

Die verwendeten Ressourcen sind abhangig von der Setup-Einstellung.
Wenn der gesamte Bereich durch Option-ROM'’s belegt wird, konnen diese Funktionen nicht mehr aktiviert
werden bzw. funktionieren nicht mehr.

Adresse Funktion
A0000-BFFFF VGA-RAM
C0000-CFFFF VGA-BIOS
DO000-E7FFF AHCI BIOS / RAID / PXE (falls verfiigbar)
E8000-FFFFF System-BIOS

Interrupt

Die verwendeten Ressourcen sind abhéngig von der Setup-Einstellung.

Die aufgefuhrten Interrupts und deren Benutzung sind durch die AT-Kompatibilitat gegeben.

Wenn Interrupts exklusiv auf der ISA-Seite zur Verfligung stehen missen, sind diese durch das
BIOS-Setup zu reservieren. Auf der PCI-Seite ist die Exklusivitat nicht gegeben und auch nicht mdoglich.

Adresse Funktion
IRQO Timer
IRQ1 PS/2 Tastatur
IRQ2 (9) COM3
IRQ3 COM1
IRQ4 COM2
IRQ5 COM4
IRQ6
IRQ7
IRQ8 RTC
IRQ9
IRQ10
IRQ11
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IRQ12 PS/2 Maus

IRQ13 FPU

IRQ14
IRO15

PCI-Devices

Die hier aufgeftihrten PCI-Devices sind alle auf dem Board vorhandenen inklusive der, die durch das BIOS
erkannt und konfiguriert werden. Durch Setup-Einstellungen des BIOS kann es vorkommen, dass
verschiedene PCI-Devices oder Funktionen von Devices nicht aktiviert sind. Wenn Devices deaktiviert
werden, kann sich dadurch bei anderen Devices die Bus-Nummer andern.

AD INTA REQ Bus Dev. Fkt. Kontroller / Slot

- - 0 0 0 Host Bridge 1D0104h
A - 0 2 0 VGA Graphics ID0116h
A - 0 25 0 LAN QM67 1D1502h
A - 0 26 0 USB EHCI Controller #2 QM67 ID1C2Dh
A - 0 27 0 HDA Controller QM67 ID1C20h
A - 0 28 0 PCI Express Port 1 QM67 ID1C10h
B - 0 28 1 [PCI Express Port 2 QM67 ID1C12h]
C - 0 28 2 [PCI Express Port 3 QM67 ID1C14h]
D - 0 28 3 [PCI Express Port 4 QM67 ID1C16h]
A - 0 28 4 PCI Express Port 5 QM67 ID1C18h
B - 0 28 5 PCI Express Port 6 QM67 ID1C1Ah
C - 0 28 6 PCI Express Port 7 QM67 ID1C1Ch
D - 0 28 7 [PCI Express Port 8 QM67 ID1C1Eh]
A - 0 29 0 USB EHCI Controller #1 QM76 ID1C26h
- - 0 31 0 ISA Bridge QM67 ID1C4Fh
B - 0 31 2 SATA Interface #1 QM67 ID1CO01h
B - 0 31 3 SMBus Interface QM67 ID1C22h
B - 0 31 5 SATA Interface #2 QM67 ID1C09h
A - m 0 0 LAN 82547L ID10D3h
A - n 0 0 PCle-to-PCI Bridge IDE111h

20 A 0 0 4 0 mPCI Slot 1

Ressourcen: SMB-Devices

Die folgende Tabelle listet die reservierten SM-Bus-Device-Adressen in 8-Bit-Schreibweise auf. Diese
Adressbereiche dirfen auch dann nicht von externen Geraten benutzt werden, wenn die in der Tabelle
zugeordnete Komponente auf dem Motherboard gar nicht vorhanden ist.

Adresse Funktion
10-11 Standard-Slave-Adresse
40-41 GPIO
60-61 Reserviert vom BIOS
70-73 POST-Code Output
88-89 Vom BIOS definierte Slave-Adresse
AO-Al DIMM 1
A2-A3 DIMM 2
Ad-AF Reserviert vom BIOS
BO-BF Reserviert vom BIOS
D2-D3 Clock
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